# Table of Contents

1 User Guide Overview .............................................................................................................. 6
   Audience ................................................................................................................................. 6
   User Guide Organization ......................................................................................................... 7
   Typographical Conventions .................................................................................................... 7
   Notes ......................................................................................................................................... 7
   Terminology ............................................................................................................................. 7

2 Adlib PDF .................................................................................................................................. 8
   Key Concepts ............................................................................................................................. 9
   Components ............................................................................................................................... 10
   Overview of the Transformation Process .................................................................................. 11
   Environment ............................................................................................................................... 11
   Sources ....................................................................................................................................... 11
   Variables ..................................................................................................................................... 11
   PDF Optimization ......................................................................................................................... 11
   Instruction Sets ......................................................................................................................... 11
   Common Functions ....................................................................................................................... 12
   Adlib Access and Log In .............................................................................................................. 15

3 Management Console ............................................................................................................. 16
   Transformation Functionality .................................................................................................... 17
   Basic Steps .................................................................................................................................. 18
   User Interface Conventions ........................................................................................................ 19

4 System Settings ....................................................................................................................... 20
   Overview ..................................................................................................................................... 20
   Environment Page ...................................................................................................................... 20
      Environment and Component Options .................................................................................... 22
      Action Menu Options .............................................................................................................. 23
      Component Options ............................................................................................................... 26
      Sort Options ........................................................................................................................... 27
      Component Initialization Settings ........................................................................................... 29
   Sources ....................................................................................................................................... 33
      Connectors .............................................................................................................................. 34
      Source Options ....................................................................................................................... 35
      Edit Menu Options ................................................................................................................... 37
   Licensing ..................................................................................................................................... 39

5 Job Settings ............................................................................................................................... 40
   Overview ..................................................................................................................................... 40
   Job Settings Page ......................................................................................................................... 40
      Instruction Sets ......................................................................................................................... 41
      Instruction Set Options ............................................................................................................. 43
   Rule Sets ..................................................................................................................................... 47
      Rule Set Editor .......................................................................................................................... 47
   Job Acceptance Rules .................................................................................................................. 49
6 Monitoring ................................................................................................................. 62
   Overview ................................................................................................................. 62
   Monitoring Page Options ..................................................................................... 63
   Job Status ............................................................................................................. 69
   Job Status Page .................................................................................................... 71
   System Status ...................................................................................................... 76
      System Status Page .......................................................................................... 77
      System Status Overview .................................................................................. 81
      System Status Component Links ................................................................... 82
   Alarms .................................................................................................................. 83
   System Log ........................................................................................................... 85
      System Log Page ............................................................................................... 87

A Frequently Asked Questions .................................................................................. 89
   What Are the Stages of Job Processing? .............................................................. 89
   How Do I Configure Adlib PDF for High Availability? ....................................... 91
   How Do I Find Out Why My Job Failed? .............................................................. 92
   What Do I Do if a Component is Generating an Alarm? ....................................... 96
   How Do I Change Logging Levels? .................................................................... 100
   How Do I Get Rid of the Input File Extension in the Rendered PDF? ............... 102
   How Do I Change the Input File Destination After Job Processing? ............... 105

B Database Growth Management .............................................................................. 106
   Database Growth Management Modes ............................................................ 106
      Configuring Database Growth Management Settings .................................... 107

C Content Transformation Viewers and Supported File Types ................................ 110
   Native Application Support (NAS) .................................................................... 110
   Adlib Viewer Support ......................................................................................... 113
   Generic Viewer Support .................................................................................... 114
      Supported File Types Table - Levels of Support ......................................... 114
   Supported File Types ....................................................................................... 115

D Troubleshooting .................................................................................................... 124
   Overview ............................................................................................................. 124
   Common Issues ................................................................................................. 124
   Adlib Tips .......................................................................................................... 125
   Using Metadata ................................................................................................. 126

E Contact Adlib ....................................................................................................... 131
User Guide Overview

This guide is intended for Users and Administrators who wish to understand the functionality of the Adlib PDF. The functionality described in this guide is restricted to the Management Console. Other elements of this system, such as Installation and Integration are available in supporting Adlib guides and reference materials.

Audience
The Adlib PDF User Guide is intended for any user who wishes to understand the basic functionality of the Adlib system. For the purposes of this guide, the term "Users" can refer to:

- System Administrators and IT staff responsible for preparing the Environment, installing, configuring, deploying, managing, troubleshooting and upgrading Adlib PDF.
- Development staff tasked with integrating Adlib PDF into their solution.
- Product Managers who wish to learn about the high level capabilities and integration options of Adlib PDF for use within their own solution.
User Guide Organization
This guide is structured to reflect the organization of the Adlib Management Console. It enables Users to find information quickly based on the task(s) being performed.

Typographical Conventions
The following typographical conventions are used throughout this guide.

<table>
<thead>
<tr>
<th>Item</th>
<th>Convention</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adlib elements</td>
<td>Teal, Title case</td>
<td>The Folder Connector integrates with file folders</td>
</tr>
<tr>
<td>Field names</td>
<td>Bold</td>
<td>Type “true” in the Value field</td>
</tr>
<tr>
<td>Field values</td>
<td>Enclosed in quotes</td>
<td>Type “true” in the Value field</td>
</tr>
<tr>
<td>Logical operators</td>
<td>Uppercase, Bold</td>
<td>AND, == EQUALS</td>
</tr>
<tr>
<td>Menu options &amp; titles</td>
<td>Bold</td>
<td>Select Transformation Rules from the Settings menu</td>
</tr>
<tr>
<td>Push buttons</td>
<td></td>
<td>Click Save</td>
</tr>
<tr>
<td>Settings</td>
<td></td>
<td>Drag Active from the Settings toolbox</td>
</tr>
<tr>
<td>Page elements and titles</td>
<td>Italic</td>
<td>Navigate to the Edit tab on the Rule Set Editor page</td>
</tr>
<tr>
<td>Window titles</td>
<td></td>
<td>Drag Active from the Settings toolbox to the work area</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Define Attribute Settings in the Edit Attribute window</td>
</tr>
<tr>
<td>Script</td>
<td>Mono code</td>
<td>${Adlib.FolderConnector.InputFileExtension}</td>
</tr>
<tr>
<td>URLs</td>
<td>Lowercase</td>
<td><a href="http://www.adlibsoftware.com/">http://www.adlibsoftware.com/</a></td>
</tr>
<tr>
<td>User-defined element</td>
<td>Enclosed in angle brackets</td>
<td>C:\Program Files\Adlib\Install Folder</td>
</tr>
</tbody>
</table>

Notes
Notes, cautions and tips are offered throughout the guide and are quickly identified by the following icons:

⚠️ Provides important cautionary notes relevant to the content.

💡 Provides helpful tips and shortcuts.

Terminology
Detailed descriptions of terminology applicable to the Adlib product can be found in the Adlib Glossary.
Adlib PDF

Adlib PDF is the next generation of Adlib transformation technology. Its design offers a high degree of flexibility for developing systems that provide scalability and high availability. An intuitive, interactive interface enables administrators to set up, configure, and troubleshoot systems that are easily configured to fulfill each user’s unique requirements.

Adlib PDF offers scalability and load balancing potential for the efficient use of system resources to maximize the volume of document conversions. Processing can be prioritized to ensure that time-critical work is done first. Health monitoring provides a window into the centralized database and instant notification of system issues, which can minimize time spent troubleshooting. Performance measurement through reporting can identify performance bottlenecks and verify that Service Level Agreements are being met. Potential issues can be anticipated and future upgrades in capacity can be planned and implemented before service is compromised.

- Key Concepts
- Components
- Overview of the Transformation Process
- Environment
- Sources
- Variables
- PDF Optimization
- Common Functions
- Adlib Access and Log In
Key Concepts

The process of document transformation begins when a Connector detects input in a Source repository that it is monitoring. When a new job becomes available, the Connector extracts the content from the Source and submits it to the Job Management Service. The Job Management Service submits the accepted job to the database.

The System Manager is constantly polling the database for jobs it can process. When a new job is detected, the System Manager evaluates the Transformation rules associated with the content from that Source, creates a job ticket and submits the ticket to the database. The Transformation Engine picks up the job, performs the transformation according to the job ticket and writes the completed job back to the database. The Connector, which has been polling the database for completed jobs, uploads the transformed job into the Source output folder or repository.

In addition to the Components that perform content transformation, Adlib PDF contains a Process Manager whose role it is to stop, start and monitor the Transformation Engine, Connector(s) and System Manager. The System Manager also monitors the health of Adlib PDF Components and reports alerts to the system administrator.

Figure 1 - Key Concepts

![Diagram of Key Concepts]
Components

Adlib PDF comprises several Components to interface with users, manage jobs, perform transformations, monitor services, and report system and job status. Adlib PDF includes the following Component types:

Connectors

A Connector Component monitors a Source for content, submits the content as a job to Adlib PDF, and receives completed job output.

Different types of Connectors integrate with various Source types:

- The Folder Connector integrates with Folder Sources.
- The Generic Connector integrates with the Web Service interface.

Job Management Service

This is a service interface within Adlib PDF used to submit and receive Jobs. It is called by Connectors and custom integrations.

Logger

This Component logs data into the Adlib PDF database.

Process Manager

This Component controls individual processes on a single machine within the Adlib system. Its role is to start, stop, monitor, and restart the processes assigned to it.

There is one Process Manager Component installed on each machine on which any Adlib Components, such as Folder Connector, are installed.

Services

This is a layer of communication services used primarily by the Management Console.

System Manager

This Component manages jobs and monitors all Adlib PDF Components. It prepares jobs for the Transformation Engine by executing the appropriate Transformation Rule Sets. It also monitors the health of Components and issues alerts to the System Administrator.

Transformation Engine

This Component performs the transformation of content.
Overview of the Transformation Process

In the most basic implementation of Adlib PDF, the user begins the transformation process by placing a document in a particular input repository, called a “Source”. A Source can be a folder or a repository that is custom designed according to the needs of the user. The document is then evaluated by a set of rules called an “Instruction Set”.

The flexibility of Adlib PDF to create rules to suit almost any business application is further enhanced with the use of metadata within rules. Metadata, which is “data about data”, can be associated with the content to be processed, such as the document template or file type, or it can be related to one of the Adlib PDF Components. For example, Component metadata could be used to determine which Transformation Engine group should process the content transformation.

Once the document has been evaluated against the relevant Instruction Set, it will be prepared according to the specifications in the rules. Adlib PDF performs the transformation and deposits the output in the specified output folder or repository.

Environment

The Environment is a group of registered Components that are assigned for use in Adlib PDF. Components must be assigned to the Environment to be activated. Based on the licensed usage, Components may be installed in a single server deployment, or in a multiple-server Environment for scalability and high availability.

Sources

A Source is a repository or structured container of digital content where input documents and metadata are drawn from. These include file folders or custom Sources built through web services. Sources must be associated with a Connector, and then assigned to an Instruction Set before input can be transformed. The content input and output folders must also be designated in the Source configuration.

Variables

Local Variables are used within Rule Sets to simplify Rule structure. For example, where complex conditions are repeated throughout a Rule Set, these conditions can be evaluated once and assigned to a local Variable which can be referenced multiple times within a Rule Set.

PDF Optimization

By default, duplicate fonts, images, ICC profiles and other data streams are removed when jobs are processed in order to produce optimized PDF output. Image down-sampling settings can also be configured according to user requirements. For more information on the options available in the Optimize Transformation Rule Setting, see the Adlib PDF Technical Reference Guide.

Instruction Sets

Instruction Sets are collections of Rule Settings. The configuration of these rules enables the user to fine-tune both document conversion and the behavior of Components within the system. There are three types of rules and settings that are used within the Adlib PDF:

- **Component Initialization Rule Sets** define configuration Settings for initialization of Components within an Environment.
- **Job Acceptance Rule Sets** enable priority and engine specific processing.
- **Transformation Rule Sets** define conversion Settings for the job.
Rule Set Editor
Rule Sets are defined and configured on the Rule Set Editor page, accessed from either Environment or Job Settings.

- The Active tab displays published Rule Sets. Active Rule Sets may be viewed but not modified.
- The Edit tab is used to create or modify Rule Sets that are inactive.

Common Functions
The following elements are common throughout the Management Console user interface:

About Button
Provides copyright and licensing details

Breadcrumbs
Displays the current screen location within the Management Console hierarchy and provide links to previous pages in the screen hierarchy. Down arrows, when available, provide quick navigation to other Settings.

Drag-and-Drop
The process of assigning Settings through a graphical operation by dragging them from the toolbox to a drop zone in the work area. A border encompasses the work area during this operation.

Action Drop-Down Menu
Displays action options in a drop-down menu.
Filter Drop-Down Menu
Restricts the display of details to a single parameter, selected from a drop-down list.

Filter Pop-Up Window
Restricts the display of log details using specific criteria.

Help Center Button
Opens the Help Center page providing access to Adlib PDF documentation.

Help Icon
Opens help content for the current Management Console screen.

Information Icon
Displays name and description properties.
Refresh Button
Available on Monitoring pages to refresh job or system details.

Configure Drop-Down Menu
Displays Configure options in a drop-down menu.

Sort Drop-Down Menu
Re-orders page details to display content in the order selected from the drop-down list.

Status Message
Provides information on recent actions.

Publish Icon
A green caution icon indicates that unpublished changes have been detected. To publish and activate the changes, click the icon.

Tool Tips
Right-click and select “What’s This” on Settings fields for pop-up descriptions.

Show/Hide Icon
Click the chevron to the right of the About button to minimize the tabs across the top of the screen (Home, System Settings, etc.) and maximize screen space. Click the symbol again to reveal the tabs.
Adlib Access and Log In

Adlib PDF is an account-based web application, requiring users to Log In using their assigned credentials.

- Enter **Username** and **Password**, then click **Submit**.

*Figure 2 - Adlib Log In*

- Click **Log Out** at the top of any page to exit Adlib PDF.

*Figure 3 - Log Out*
Management Console

The web-based administrative console provides centralized management of Adlib PDF for system configuration, health monitoring, and reporting.

The Home page provides an overview of the Management Console with Quick Access shortcuts to three functional areas:

- **System Settings** to configure Components and define Sources.
- **Job Settings** to configure Instruction Sets.
- **Monitoring** to monitor and troubleshoot jobs and system Components.

A System Status Overview provides a graphical view of the health status of Adlib system Components.

Figure 4 - Management Console Home Page
Home Page
The Home page provides quick links to other areas of the Management Console and a System Status Overview. The System Status Overview visually identifies the health status of all working Components of Adlib PDF and provides access to status logs to troubleshoot any issues. Each box in the Overview represents a Component category.

- Status indicators provide warnings when Components are in a faulted or stalled state.
- Clicking on a Component box in the Overview opens the System Status page, filtered to display status information for the selected Component category.

Refer to System Status Overview within Monitoring for details.

System Settings Page
Use the System Settings page to configure system Components and define Sources of content.

Refer to System Settings for details.

Job Settings Page
Use the Job Settings page to define job processing Instruction Sets and to associate them with Sources of content.

Refer to Job Settings for details.

Monitoring Page
Use the Monitoring page, in conjunction with the System Status Overview, to monitor Component health and troubleshoot failure issues.

Refer to Monitoring for details.

Transformation Functionality
Using the transformation functionality of Adlib PDF:

- Components are assigned to an Environment and configured,
- Sources are defined as repositories of documents to be transformed,
- Instruction Sets, comprising processing Rules for Job Acceptance and Transformation, are configured,
- Connectors are assigned to integrate Environment Components and Sources with Instruction Sets,
- Monitoring provides insight into system and job performance.
Basic Steps

Setup, configuration, and use of Adlib PDF can be completed in five basic steps:

1. Define Additional Source(s) or Modify Defaults
   - Navigate to the Sources tab on the System Settings page.
   - Use the Default Source provided or follow instructions To Define a New Folder Source.

2. Configure Job Settings
   - Navigate to the Job Settings page.
   - Use the Default Instruction Set provided or follow instructions to To Define a New Instruction Set.
   - Optionally, follow instructions Replacement Variables.
   - Follow instructions to Publish an Instruction Set.

3. Verify System Readiness
   - Navigate to the Home page.
   - If the System Status Overview indicates that any Components are in alarm state, follow the instructions To Acknowledge Alarms.

4. Submit Job
   - Ensure all the previous steps are complete and Adlib PDF is up and running error free.
   - Submit a document to be converted:
     - Ensure input documents are available for the defined Source.
     - When the Source detects the arrival of the document, it submits a job for processing.
   - Navigate to the Job Status tab on the Monitoring page to view job information.
   - If the job did not complete successfully, refer to Monitoring or Troubleshooting to diagnose the problem.
   - Open the output location defined for the Source to view results.
User Interface Conventions

The following terms are used throughout this guide to describe common elements within the user interface:

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>When Components are not operating normally (Started, Stopped or Installed status), users are alerted with flashing status indicators on the System Status Overview.</td>
</tr>
<tr>
<td>Database</td>
<td>A collection of data related to Adlib PDF (e.g. Components, Rule Sets, Job configurations, Environment, Job Status information, System Log details, etc.).</td>
</tr>
<tr>
<td>Drop Zone</td>
<td>A specific location within the work area where dragged Settings are dropped.</td>
</tr>
<tr>
<td>Heartbeat</td>
<td>Identifies the health status of Components in Adlib PDF.</td>
</tr>
<tr>
<td>Publishing</td>
<td>The process of taking the Environment Settings or Instructions Sets from edit mode and making them active.</td>
</tr>
<tr>
<td>High Availability</td>
<td>Multiple instances of the same Component that allow Adlib PDF to continue operating in the event that one or more Components fail. Also referred to as Redundancy.</td>
</tr>
<tr>
<td>Toolbox</td>
<td>The location on a page where items that can be dropped into the Work Area reside. Toolbox items include the following:</td>
</tr>
<tr>
<td></td>
<td>• Unassigned Components, on the Environment page,</td>
</tr>
<tr>
<td></td>
<td>• Source Types, on the Sources page,</td>
</tr>
<tr>
<td></td>
<td>• Unassigned Sources, on the Job Settings page, and</td>
</tr>
<tr>
<td></td>
<td>• Rule Settings and Saved Settings on the Rule Set Editor page.</td>
</tr>
<tr>
<td>Work Area</td>
<td>The location on the page where Settings are configured; available on Environment, Sources, Job Settings, and Rule Set Editor pages.</td>
</tr>
</tbody>
</table>
System Settings

Overview
System Settings provides functions for configuring Adlib PDF. Four tabs provide general system functions to:

- Configure installed Components within the Environment Page.
- Define Sources of documents to be transformed.
- Review Licensing information.

Environment Page
The Environment defines the working system in which Components reside. Components must be assigned to an Environment to be activated. Components may be installed in a single server deployment, or in a multiple-server Environment for scalability and high availability. Environment Components include:

- System Manager
- Job Management Service
- Transformation Engine
- Process Manager
- Logger
- Folder Connector
- Generic Connector

The Environment tab on the System Settings page, displays a toolbox of installed Components on the left and a work area where the Environment is configured on the right. The defined Environment is displayed in the work area.

Within the Environment box, a drop zone identifies the area where Components are assigned.

Components must be assigned to become active.
The Environment must include at least one of each of the Functional Components and one or more of the Connector Components, described below:

### Functional Component

<table>
<thead>
<tr>
<th>Functional Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Management Service</td>
<td>This is a service interface within the Adlib PDF used to submit and receive Jobs. It is called by Connectors and custom integrations. Users can choose to install either an IIS-based or Self-hosted Job Management Service.</td>
</tr>
<tr>
<td>Process Manager</td>
<td>This Component controls individual processes on a single machine within the Adlib system. Its role is to start, stop, monitor, and restart the processes assigned to it. One Process Manager Component is installed on each machine on which any Adlib Components, such as Folder Connector, are installed.</td>
</tr>
<tr>
<td>Services</td>
<td>This is a layer of WCF-based (Windows Communication Foundation) services used primarily by the Management Console. User can choose to install either IIS-based or self-hosted Services.</td>
</tr>
</tbody>
</table>
Environment and Component Options

When a complete Adlib PDF installation is performed, all Components are automatically assigned to the Environment. During a custom installation, the Components are also assigned by default with the exception of the Connectors which must be manually assigned. Once Components are configured, the Environment must be published, which places all Components into active mode. A default Environment is provided when Adlib is installed.

- **Assign one or more Components to the Environment**
  
  Drag the Component(s) from the *toolbox* to the *work area*.

**Figure 6 - Assign Environment Components**
The **Action** menu in the Environment’s *work area* provides the following options:

- Import an Environment
- Export an Environment
- Publish Environment
- View Environment Properties

*Figure 7 - Environment Action Menu*

The following **Sort** options enable Components to be reordered on the *Environment* page:

- Sort Environment Components
- Sort Unassigned Components

The following **Component** options provide additional functionality:

- Remove Environment Components
- Unregister Environment Component
- View Component Details

**Action Menu Options**

- View Environment Properties
  
  Select **Properties** from the Action menu to view or update the Environment **Name** or **Description** in the *Environment Properties* window.

- Export an Environment
  
  Export Environment settings to a file, for reuse in another installation of Adlib PDF.

  Environments in either Edit or Active mode may be exported.
1. Select **Export** from the Action menu.
2. In the *Export Environment* window, select the **Rule Set Types** to be exported or **Select All**.
3. Click the ellipsis button to define the export file name and location.
4. Click **Export**. A status message confirms if the export was successful.

*Figure 8 - Export Environment*

![Export Environment](image)

**Import an Environment**
Import Environment settings from a previously exported file.

Files may only be imported to an Environment that is in Edit mode.
1. Select **Import** from the Action menu.
2. When prompted, browse to the Environment file and click **Open**.
3. In the *Import Environment* window, select to import the Environment in either **Active** or **Edit** state.
4. Select the **Rule Set Types** to be imported.
5. Click **Import**. A status message confirms if the import was successful.

*Figure 9 - Import Environment*

![Import Environment](image)

**Publish Environment**

Publishing an Environment places all Environment Components into **Active** mode.

1. Select **Publish** from the Action menu or click the Publish icon. A status message confirms publication.

*Figure 10 - Publish Icon*
Component Options

- Remove Environment Components
  Removing a Component from an Environment and stopping the Process Manager stops all operations performed by that Component. For example, removing a Source will stop all jobs submitted by that Source; removing an Engine will stop any additional jobs being sent to that Engine.
  - Drag the Component to be removed from the Environment’s work area to the Unassigned Components toolbox.
  - Only Components that are NOT currently assigned to a Source may be removed from an Environment.
  - Uninstall the Component from the database.

- Unregister Environment Component
  Components that no longer reside in the database need to unregistered. This is required if the Component was uninstalled without first being unassigned from an Environment or if the machine on which the Component resided is no longer available.
  1. Unassign the Component from the Environment.
     - Drag the Component from the Environment’s work area to the Unassigned Components toolbox.
  2. In the Unassigned Components toolbox, click the arrow beside the Component name.
  3. Click Unregister. When prompted for confirmation, click OK.

Figure 11 - Unregister Component
Sort Options

Sort Environment Components

When multiple Components have been assigned to an Environment, the order in which Components are listed may be changed.

1. Click the Sort down arrow within an Environment work area to open the Component Sort menu.
   - Click Machine Name to sort Environment Components by the name of the machine on which the Component resides.
   - Click Component Type to sort Environment Components by the type of Component (Folder Connector, Services, etc.).

Figure 12 - Sort Environment Components

Sort Unassigned Components

1. Click the Sort down arrow at the top of the toolbox to open the Unassigned Components Sort menu.
   - Click Machine Name to sort Unassigned Components by name of the machine on which the Component resides.
   - Click Component Type to sort Unassigned Components by their type.

Figure 13 - Sort Unassigned Components
View Component Details

Click the arrow beside a Component name to display or hide Component details, including the name of the Component and the path where the Component is installed.

Figure 14 - Component Information
Component Initialization Settings

Once Components are assigned, they can be configured to fine-tune the system according to your needs. For a comprehensive list of all System Settings available within Adlib PDF, please refer to the Adlib PDF Technical Reference Guide.

Ensure that all paths used in Component Settings conform to the Windows limit of <260 characters.

- Select the Component to be configured from the Configure menu. The Rule Set Editor page displays settings specific to the Component selected.

Figure 15 - Environment Configure Menu

Rule Set Editor Page

The Rule Sets Editor page displays a work area where Rule Sets are defined, and a toolbox from which Rules and Settings are assigned.

- The Active tab (opens by default) displays published Rule Sets. Active Rule Sets may be viewed but are locked from editing.

- The Edit tab is used to create or modify Rule Sets that are inactive.

Drag a Rule from the toolbox to the rule drop zone. Drag a setting from the toolbox to the setting drop zone. Edit Menus provide options to configure Rules and settings.

All changes to System Settings must be activated by publishing the Environment.
Click the down arrow in the breadcrumb trail to navigate to other Environment Components.

**Figure 17 - Navigate to Environment Components**

**System Manager**

System Manager Components manage jobs received via web services and monitor other Components.

- **System Manager** to define settings specific to System Manager (e.g. intervals, maximum counts, e-mail settings, completed job retention, database growth management),

  For more information on the Database Growth Management application settings and defaults, see [Database Growth Management](#).

- **Output Mapping** to define file extension mapping for Output documents (for example, Microsoft Word output documents map to .doc file extension, PDF output documents map to .pdf file extension).
Job Management Service

Job Management Service Components manage jobs. The following Rule Settings are available:

- **Job Management Service** to define settings specific to Job Management Service (e.g. intervals, e-mail settings, job log retentions),
- **Boolean, Integer, and String Variables**.

Transformation Engine

Transformation Engine Components perform the transformation of files. Settings include:

- **Transformation Engine** to define settings specific to the Transformation Engine (e.g. intervals, limits, stored procedure name, job filters, group name),
- **Engine Settings** to configure Transformation Engines,
- **Engine Registry** to configure Transformation Engine registry settings. The defaults set at installation can be modified as necessary.

- **Fault Monitoring and Recover (FMR) settings include:**
  - **Restart**: Enabling Restart causes the Transformation Engine to automatically shut down and restart after processing the specified number of documents. This function was implemented to maximize Adlib’s reliability and to recover memory consumed by the Windows Operating System and application software (e.g. Microsoft Word, Excel, etc.). This setting is enabled by default after 300 documents.
  - **Job Timeout**: A Job Timeout occurs when any Job takes longer to process then the specified timeout period. Regardless of whether or not the Transformation Engine is still sending messages to Adlib FMR, if the Job takes longer then the timeout specified, the Job is terminated. The Job Timeout setting is disabled by default. Note: The recommended Job Timeout length is 1200 seconds at the minimum; this length should be increased if large jobs are regularly processed.
  - **Inactivity Timeout**: The Inactivity Timeout occurs when absolutely no messages are returned by the Transformation Engine within the specified timeout period. The document conversion is terminated. This setting is enabled by default after 600 seconds.

- **Other Transformation Engine Registry Settings include:**
  - **Document Rendering**
  - **PDF Driver**
  - **Native Applications**
  - **Output to Text Rendering Settings**
  - **ECAD Settings**
  - **Registry Values (user-defined registry keys)**

For more information on the Engine Registry settings that are available in Adlib PDF, please see the Adlib PDF Technical Reference Guide.

The True/False values must be used to enable or disable the Engine Registry Settings; simply clearing a checkbox will not disable a setting.
Process Manager

Process Manager Components are responsible for launching and monitoring Adlib Components. Settings include:

- **Process Manager** to define settings specific to the Process Manager (*e.g.* acknowledge logon message, keep alive interval),
- **Executable** to define settings for launching an Executable (*e.g.* path, parameters, username, session, etc.),
- **Folder Connector** to define settings for launching a Folder Connector (*e.g.* path, parameters, username, etc.),
- **Service** to define settings for launching a Window Service (*e.g.* service name),
- **System Manager** to define settings specific to the System Manager (*e.g.* service name, component),
- **Transformation Engine** to define the settings specific to the Transformation Engine (*e.g.* path, parameters, directories, run attributes),
- **Engine** to configure the Transformation Engines,
- **Users** to define Users (*e.g.* usernames, passwords, descriptions).

Logger

Logger Components manage job logging and diagnostics. Settings include:

- **Context List**
- **Context Refresh Interval**
- **Log Settings**

Folder Connector

Folder Connector Components integrate with monitored folders. Settings include:

- **Behavior Settings** to define Job Folders and Job Files behavior (*e.g.* error and work folder locations, input and output file naming/handling, etc.),
- **Boolean, Integer, and String Variables**,  
- **Helper Applications** to define the Connector Helper Applications (*e.g.* class name, context, execution attributes),
- **Submitter Performance** to define settings specific to Connector submitter performance (*e.g.* thread pool, job throughput),
- **Receiver Performance** to define settings specific to Connector receiver performance (*e.g.* thread pool, job throughput),
- **Sources** to define the Source configuration value.

Generic Connector

Generic Connector Components integrate with the Web Service interface. Settings include:

- **Generic Connector** to define custom Connector settings.
Sources
Sources are repositories of content where input documents and metadata are drawn from. These include folders or generic Sources built through web services. Adlib can receive content from any number of Sources.

The Sources page, accessed from the System Settings tab, displays a work area where Sources are defined, and a toolbox from which installed types of document Sources (e.g. Folder, SharePoint, Generic) are assigned. Define a new Source by dragging a Source Type from the toolbox to the source drop zone in the work area.

Figure 18 - Sources Page
Sources are monitored for activity by an assigned Connector. A default Source is provided when Adlib is installed.

By default, Sources are displayed in order by Name. However, the sort order may be changed using the Sort Menu.

A Filter Menu restricts the Source list by Source type.

The Action Menu provides options to edit and delete defined Sources.

An Information icon displays Source descriptions.

Connectors
Connector Components integrate with external systems, monitoring input Sources for activity, delivering input documents and metadata for processing, querying for job completion, and delivering results. Different types of Connectors integrate with various Source Types:

- The Folder Connector integrates with file folders.
- The Generic Connector integrates with the Web Service Interface.
Source Options
Define Sources and assign Connectors.

To Define a New Folder Source
1. On the Sources page, drag a Folder Source Type from the toolbox to the work area.

Figure 19 - Drag-and-Drop Sources

2. When prompted, type a Name and optional Description in the Properties window.

Figure 20 - Source Properties

3. Select Edit from the Edit menu to configure the Source.

Figure 21 - Source Edit Menu

- For Folder Source Types, identify folder locations. These must be accessible by the machine on which the Folder Connector Component is installed.
  - The Input folder identifies the location the Connector checks for activity (where files to be transformed are placed).
  - The Output folder is where processed files are located.
For **Generic Source Types**, identify the Connector **Name** and **Description**.

4. Add a Connector to monitor the Source.
   - Select the Connectors plus sign, then click the Connectors down arrow and select the appropriate **Connector** type from the drop-down list.

5. Click **Save**.

6. As a final step, the **Environment** must be published to reinitialize the Connector to recognize any new Sources that have been added to the system. To do so, navigate to the **Environment** tab on the **System Setting** page and click the green caution icon to publish the changes.
The Edit menu in the Source’s work area provides the following options:

- Delete a Source
- View or Modify Source Properties
- Modify Source Connectors

The following options provide options to sort or filter source details:

- Sort Sources
- Filter Sources

**Edit Menu Options**

**Delete a Source**

Sources may only be deleted if no Connectors are assigned.

1. Select Delete from the Edit menu.
2. When prompted, click OK to confirm. A status message confirms successful deletion.

**Tip**

Click the pencil to quickly enable Edit mode.
**View or Modify Source Properties**

1. Select **Properties** from the Edit menu.
2. Update the Source Name or Description and click **Save**.
3. To view Source information, hover over the **Information** icon.

*Figure 27 - Source Information*

![Folder Source](image)

**Modify Source Connectors**

1. Select **Edit** from the Edit menu.
2. To remove a Connector,
   - Click the X beside the Connector name.
3. To change a Connector,
   - Click the down arrow beside the Connector name and select another Connector from the drop down list.

**Sort Sources**

Click the **Sort** down arrow to open the Sort menu.

- Select **Name** to order the list of Sources by Source Name.
- Select **By Type** to order the list of Sources by Source Type.

*Figure 28 - Sources Sort Menu.*

**Filter Sources**

Click the **Filter** down arrow to open the Filter menu.

- Select a **Source Type** from the drop-down list to restrict the list of Sources to that Source Type only.
Licensing

The Licensing Page displays the license(s) associated with the Adlib PDF system. Licenses are grouped by feature; each group includes a list of all servers that contain those features. If applicable, the Software Maintenance Plan expiry date is shown in the page heading. If more than one Maintenance Plan has been purchased, the date of the Plan to expire first will be displayed.

To view the License Key installed on a particular server within a feature group, expand the server list. If the License Key has an expiry date (e.g. an Evaluation License), it is listed in the table.

Figure 29 - Sources Filter Menu

Figure 30 - Licensing Page

Figure 31 - License Information Displayed by Server
Job Settings

Overview
Job Settings provide configuration functions for defining job processing Instruction Sets. This includes managing job acceptance criteria and defining Rules and Variables required for the configuration and transformation of content. Use Job Settings functions to:

- Define Instruction Sets and assign Sources.
- Optionally, define Local Variables.

Job Settings Page
The Job Settings tab, accessed from the System Settings page, displays a toolbox of Unassigned Sources on the left and a work area where Instructions Sets are configured on the right. Defined Instruction Sets are displayed in the work area. Within the Instruction Set box, a drop zone identifies the area where Sources are assigned.

Figure 32 - Job Settings page
Instruction Sets

Instruction Sets are groups of job processing Rule Sets that are evaluated on a per job basis when documents arrive in an associated Source. Each Instruction Set is associated to one or more Sources and are configured with Job Acceptance and Transformation Rule Sets.

- **Job Acceptance Rules** enable priority and engine specific processing.
- **Transformation Rules** define conversion Settings used to configure how documents are transformed.

To Define a New Instruction Set.

1. On the *Job Settings* page, click **New Instruction Set**.
2. When prompted, type the Instruction Set **Name** and optional **Description** in the *Properties* window.

![Figure 33 - Instruction Set Properties](image)

3. The new Instruction Set is displayed in the work area.

![Figure 34 - New Instruction Set](image)
4. Assign one or more Sources to the Instruction Set.
   - Drag an Unassigned Source from the toolbox to the Instruction Set’s drop zone.

*Figure 35 - Drag-and-Drop Source*

شرع

**To Unassign a Source**

Removing a Source Component terminates the association with the Instruction Set, however, the Source remains available.

- Drag the Source from the work area to the toolbox.

 vários

Only Sources with NO assigned Components (e.g. Connectors) may be unassigned from an Instruction Set.

The Action menu in the Instruction Set’s work area provides the following options:

- View Instruction Set Properties
- Delete an Instruction Set
- Export an Instruction Set
- Import an Instruction Set
- Publish an Instruction Set

*Figure 36 - Instruction Set Action Menu*
**Instruction Set Options**

- **Search Instruction Set Names**
  
  Enter a full or partial Instruction Set name in the Search box and press Enter. Search results are displayed in the work area below. Click the X in the Search box to clear the search and re-display the page.

  *Figure 37 - Instruction Set Search box*

- **View Instruction Set Properties**
  
  Select **Properties** to view or update the Instruction Set **Name** or **Description** in the Instruction Set Properties window.

- **Delete an Instruction Set**
  
  Only Instruction Sets with NO assigned Sources may be deleted.
  
  1. Select **Delete** from the Action menu.
  2. When prompted, click **OK** to confirm deletion. A status message confirms successful deletion.
### Export an Instruction Set

Export the Instruction Set to a file, for reuse in another Instruction Set.

Instruction Sets in either Edit or Active mode may be exported.

1. Select **Export** from the Action menu.
2. In the *Export Instruction Set* window, select the **Rule Set Types** to be exported or **Select All**.
3. Click the ellipsis button to define the export file name and location.
4. Click **Export**. A status message confirms if the export was successful.

*Figure 38 - Export Instruction Set*
Import an Instruction Set

Import an Instruction Set from a previously exported file. Any existing rules will be over-written by the imported Instruction Set.

Files may only be imported to Instruction Sets that are in Edit mode.

1. On the Edit tab of the Rule Set Editor page, select Import from the Instruction Set's Action menu.
2. When prompted, browse to the saved Instruction Set file and click Open.
3. In the Import Instruction Set window, select to import the Instruction Set Settings from either the Active or Edit state.
4. Select the Rule Set Types to be imported.
5. Click Import. A status message confirms if the import was successful.

Figure 39 - Import Instruction Set

6. To view the imported Settings,
   - Select the Rule Set Type from the Instruction Set’s Setting menu,
   - Navigate to the Edit tab of the Rule Set Editor page,
   - The Rule Set will be updated with the imported Settings.
**Publish an Instruction Set**

Publishing an Instruction Set places all related Rule Sets into Active mode and enables the Instruction Set for processing.

A green caution indicator identifies Instruction Sets with unpublished changes.

*Figure 40 - Unpublished Indicator*

- Select **Publish** from the Instruction Set’s Action menu or click the caution indicator.

*Figure 41 - Publish Instruction Set*

- A status message confirms that publication was successful.

*Published Instruction Sets are displayed in the Active tab of the Rule Set Editor page as view only. Published Rule Sets may only be edited under the Edit tab and then must be re-published as a new version. Editing done under the Edit tab does not affect published Settings.*
Rule Sets
Once Instruction Sets are defined and Sources assigned, Job Acceptance and Transformation Rule Sets may be accessed using the Configure Menu on the Job Settings page.

To Define Rule Sets
1. On the Job Settings page, click the Configure down arrow to open the Configure Menu.
2. Select the type of Rules to be defined (Job Acceptance or Transformation) from the drop-down list.

Figure 42 - Configure Menu

3. The Rule Set Editor page is displayed providing Settings specific to the Rule type selected.

Record locking prevents multiple users from editing the same Rule Set at the same time.

Rule Set Editor
The Rule Sets Editor page displays a toolbox of Rules and Settings on the left and a work area, where Rule Sets are configured, on the right. Defined Rule Sets are displayed in the work area:

The Rule Sets Editor page displays a work area where Rule Sets are defined, and a toolbox from which Settings are assigned.
- The Active tab (opens by default) displays published Rule Sets. Active Rule Sets may be viewed but are locked from editing.
- The Edit tab is used to create or modify Rule Sets that are inactive.

Drag a setting from the toolbox to the setting drop zone. Edit Menus provide options to configure settings.
The toolbox on the Rule Set Editor page contains the Settings that can be used to configure Rule Sets. The toolbox lists available Settings specific to the type of Rule Set being defined:

- **Job Acceptance Rule Sets** define criteria that constitutes acceptance or denial of a job based on metadata values.
- **Transformation Rule Sets** define conversion Settings for the job.

Dragging an item from the toolbox to the work area simply takes a copy of the Setting, working much the same way as a template.

**Rule Settings Categories**

Rule Settings are categorized in the toolbox according to function, such as file conversion or file processing.

**Settings Search**

To search for a Rule Setting, enter a full or partial Setting name in the Search box and press Enter. Search results are displayed in the work area below. Click the X in the Search box to clear the search and re-display the page.
# Job Acceptance Rules

The **Job Acceptance Rule Set** includes, but is not limited to, the following Settings:

<table>
<thead>
<tr>
<th>Category</th>
<th>Rule Settings within the Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Settings</td>
<td>Names</td>
<td>Explicitly defines the names of the document properties included in the job.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- “All” instructs the System Manager to read all properties from a document and include each as metadata name/value pairs for the job.</td>
</tr>
<tr>
<td>Job Acceptance Settings</td>
<td>Group Name</td>
<td>Identifies the Group to which the job is assigned.</td>
</tr>
<tr>
<td></td>
<td>Priority</td>
<td>Transformation Engines can be configured to only process jobs from specific Groups. For more information on the System Settings available for the Transformation Engine and other Components, see the Adlib PDF Technical Reference Manual.</td>
</tr>
<tr>
<td>User Defined</td>
<td>Name of Value</td>
<td>These Rule Settings can be used to submit user-defined values of various types, such as Guids, Integers and XML.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>String</td>
<td></td>
</tr>
<tr>
<td></td>
<td>XML</td>
<td></td>
</tr>
</tbody>
</table>

For more information on the procedure for creating Job Acceptance rules within an Instruction Set, please see [Creating a Job Processing Rule](#).
Transformation Rules

Adlib PDF provides many Transformation Rule Settings that can be used to specify how files are to be rendered during content transformation. Each Rule Setting contains various elements such as margin size, image compression rate, etc., that can be defined by the user in order to produce the desired output.

Content Transformation Viewers

During content rendering, the Transformation Engine uses a "viewer" to open a file in preparation for transformation to the specified format. There are 3 types of viewers used by Adlib PDF: native application viewers (e.g. Microsoft Word), Adlib file-type viewers, and a Generic viewer. Each viewer is used to render specific file types; viewers are automatically selected by the Transformation Engine during job processing based on file header and/or extension information.

If desired, viewers can be configured to apply specific defaults (such as image compression settings or font embedding) to the transformation of documents through the use of viewer or file type-specific Rule Settings. Although not strictly necessary for Native Application file processing, these settings provide more precise control of document rendering attributes.

Important: In order to process file types that are not associated with a Native Application or the Adlib viewer type, the Generic viewer Rule Setting must be part of the Instruction Set used to render the file. Native applications must be installed on the same machine as the Transformation Engine in order to be used as viewers.

Please refer to the Content Transformation Viewers and Supported File Types Appendix in this Guide to determine which viewer is required for the file type you wish to process.

Rule Settings Categorization

Rule Settings are categorized on the left pane of the Rule Set Editor according to function and output. For example, the setting used to configure the rendering of elements such as fonts and images when converting MS Excel files into PDF output is located within the Convert to PDF category.

Figure 45 - Rule Setting Category Expanded
## Transformation Rule Settings and Categories

<table>
<thead>
<tr>
<th>Category</th>
<th>Rule Settings within Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert to File Type</td>
<td>Name of Native Application Viewer</td>
<td>These Rule Settings allow the user to configure attributes that are specific to the type of document created by the native application.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Convert to HTML</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Convert to PDF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Name of Non-Native Application Viewer</td>
<td>Currently, the only Rule Setting to fit this description is the Generic Setting, which enables the user to control embedded fonts and image compression and resolution for file types that are rendered using the Generic viewer. It must be included in the Instruction Set in order to enable the processing of files of this type.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Generic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Input File Type</td>
<td>These Settings are named according to the input file type and are always rendered with a built-in Adlib viewer. For example, the “OCR” setting within the &quot;ConvertToPdf&quot; category will convert OCR files to PDF using the Adlib OCR viewer. A list of supported input file types and associated viewers can be found in the <a href="#">Content Transformation Viewers and Supported File Types</a> Appendix.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• OCR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Text</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Image</td>
<td></td>
</tr>
<tr>
<td>PDF Processing</td>
<td>Name of Setting Attribute(s)</td>
<td>These Rule Settings do not specify native application viewers or input file types, but rather identify the type of transformation design elements contained within the Rule Setting. For example, the Setting &quot;Header&quot; enables the user to specify the text, orientation, font, and page location(s) of the header that is applied once the input file has been rendered to PDF.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Bookmark,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Overlay</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Watermark</td>
<td></td>
</tr>
<tr>
<td>JPEG/TIFF Processing</td>
<td>Name of Setting Attribute(s)</td>
<td>These Rule Settings can be used to configure processing instructions for Jpeg and Tiff input. These Settings can be used in addition to Convert to a Jpeg/Tiff conversion setting if using a different input file type (e.g. Word file).</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Compression</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Resolution</td>
<td></td>
</tr>
<tr>
<td>User Defined</td>
<td>Name of Value</td>
<td>These Rule Settings can be used to submit user-defined values of various types, such as Guids, Integers and XML.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• String</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• XML</td>
<td></td>
</tr>
</tbody>
</table>
Rule Setting Descriptions
A description of the Rule Setting, including which viewer will be used to render the document, or which input or output file is associated with the Setting, is displayed when the user right-clicks the mouse over a Rule Setting in the left banner, then clicks the What’s this? message box.

Figure 46 - What’s This? Rule Setting Descriptions
**Replacement Variables**

The following replacement variables can be used when defining Header, Footer, and Watermark Transformation Rule Settings:

- Current Page Number: &Page
- Total Number of Pages: &Pages
- Date: &Date
- Time: &Time

For example, to insert the page number into a footer, type &Page in the desired Text field in the Footer Rule Setting.

*Figure 47 - Page Number Replacement Variable*
Creating a Job Processing Rule

The following procedure can be used as a guide to creating any type of Job Acceptance or Transformation Rule. Configuration Rules (System Settings) are created in the same manner, but are not maintained in Instruction Sets. These rules are defined by Component and are accessed from the Configure menu on the Environment page. Please see Job Setting Samples for more examples of Transformation Rules.

To Define Rules and Rule Settings

1. Before beginning, ensure that the appropriate Connector has been installed and registered in the Environment, and that a Source and Instruction Set have been created.
2. On the Rule Set Editor page, click the Edit tab to enable the Instruction Set for editing.
3. Assign Settings to the Instruction Set:
   - Expand the appropriate Settings category
   - Drag a Setting from the toolbox to the setting drop zone.

Figure 48 - Assign Transformation Setting

4. Select Edit from the drop-down menu.

Figure 49 - Transformation Setting Edit Menu
5. Define the Setting attributes in the Attribute window.
   - Type an **Attribute Name** and optional **Description**.
   - Under the **Design** tab, select details as required for the Attribute selected:
     - Click the green up or down arrow to collapse or expand attribute details.
     - Click **Metadata** to select Variables and values from the **Metadata Selector** window.
     - Click **Use Default** to revert to default values.

*Figure 50 - Setting Attributes Window*
6. To view the XML code created for the Attribute, click the Source tab.

Figure 51 - Settings Source

Although some users may require the flexibility of editing their Settings through XML code, Adlib strongly recommends limiting this practice as direct modification of XML code can be difficult to troubleshoot and maintain.

Contact Adlib for assistance in editing your settings through XML code.

7. Click OK to return to the Rule Set Editor.
8. Repeat the above steps to configure additional Settings, as required.
9. Click Save on the Rule Set Editor page to save this Transformation Rule Set.
   • A status message confirms if the save was successful.
10. A warning indicator on the Job Settings page identifies these changes as unpublished. Publishing is necessary to activate the Rules. To publish the rules, click the warning indicator.

Figure 52 - Instruction Set Unpublished
Local Variables
Rule Sets can employ multiple Variables. Default Variables are provided with Adlib PDF, however additional Variables may be defined.

**To Define a Variable**

1. On the Rule Set Editor page, click Add beside Local Variables.

   *Figure 53 - Add Variable*

2. Define the Variable in the Variable Details window.
   - Type a Variable Name and optional Description.
   - Select a Data Type from the drop-down list.
   - Type the Value of the Variable.
   - Click Save to return to the Rule Set Editor.

   *Figure 54 - Variable Details*

3. The variable is added to the Local Variables list.

   *Figure 55 - Variables List*
• Click the **pencil** icon to edit Variable details.
• Click the **X** to remove the Variable. When prompted, click **OK** to confirm deletion.

Use Variables when defining Settings, the same way as Metadata Variables are used.
Job Setting Samples
This section identifies the steps required for common Job Setting configurations. Use the procedures outlined below for reference purposes.

Procedure One - Add a Header
This procedure illustrates how to add a header to a converted Source document.
1. Navigate to the Source tab on the System Settings page.
2. Create a Folder Source (if required):
   - Drag Folder from the Source Types toolbox to the drop zone in the work area.
   - Enter the Name “Folder Source” in the Properties window.
   - Select Edit from the Edit drop-down menu.
   - In the Input field, type the location of the input folder.
   - In the Output field, type the location of the output folder.
   - Click the Connectors plus sign and select Folder Connector from the drop-down list.
   - Click Save.
   - Publish the Environment.
3. Navigate to Job Settings. The Folder Source you just created should appear in the Unassigned Sources toolbox.
4. Create a Header Instruction Set:
   - Click New Instruction Set.
   - Enter the Name “Header” in the Properties window and click Save.
   - Drag Folder Source from the toolbox to the drop zone for the Header Instruction Set you just created.
5. Create Header Transformation Rule:
   - Select Transformation Rules from the Settings menu of the Header Instruction Set.
6. Configure Header Setting:
   - Expand the PDF Processing Settings category
   - Drag the Header Setting from the toolbox to the setting drop zone.
   - Edit the Header Setting.
   - In the Job.Header attribute window, type a Name and configure attributes as required.
   - The illustration below displays sample Settings.
   - To revert to default values, click Use Default beside the Setting field.
   - Click OK to return to the Rule Set Editor.
7. **Save** the Instruction Set.
8. Navigate to the *Job Settings* page.
9. In the Header Instruction Set, select **Publish** from the Action menu.

These processing instructions are now active and ready to process a Source document.

**Procedure Two - Enable Optical Character Recognition (OCR)**

This procedure illustrates how to create a searchable PDF using OCR.

- Adlib’s Optical Character Recognition (OCR) capabilities recognizes textual information in scanned documents and renders documents in a text-searchable PDF format.

1. Navigate to the *Source* tab on the *System Settings* page.
2. Create a Folder Source (if required):
   - Drag **Folder** from the *Source Types toolbox* to the *drop zone* in the *work area*.
   - Enter the **Name** “Folder Source” in the *Properties* window.
   - Select **Edit** from the Edit drop-down menu.
   - In the **Input** field, type the location of the input folder.
   - In the **Output** field, type the location of the output folder.
   - Click the Connectors plus sign and select **Folder Connector** from the drop-down list.
   - Click **Save**.
   - **Publish** the Environment.
3. Navigate to Job Settings. The **Folder Source** you just created should appear in the **Unassigned Sources toolbox**.

4. Create an OCR Instruction Set:
   - Click **New Instruction Set**.
   - Enter the Name “OCR” in the Properties window and click **Save**.
   - Drag **Folder Source** from the toolbox to the drop zone for the OCR Instruction Set you just created.

5. Create OCR Transformation Rule:
   - Select **Transformation Rules** from the **Settings** menu of the OCR Instruction Set.

6. Configure OCR Setting:
   - Expand the **Convert to PDF Settings category**
   - Drag the **OCR Setting** from the toolbox to the setting drop zone.

7. Edit the OCR Setting:
   - In the Job.Header attribute window, type a **Name** and configure attributes as required.
     In the following example, the job will recognize both English and French text.
     
     ![OCR Attributes](image)

     To revert to default values, click **Use Default** beside the Setting field.
   - Click **OK** to return to the **Rule Set Editor**.

*Figure 57 - OCR Attributes*

8. **Save** the Instruction Set.

9. Navigate to the **Job Settings** page.

10. In the OCR Instruction Set, select **Publish** from the Action menu.

    These processing instructions are now active and ready to process a Source document.
Monitoring

Overview

Adlib PDF provides a reporting mechanism for Component health monitoring, troubleshooting, and system and job logging. Four tabs are available:

- **Job Status** provides information on submitted jobs
- **System Status** identifies the health status of Components
- **System Log** displays logs of events (e.g. Component Initialization, job details, health monitoring, etc.)

*Figure 58 - Monitoring Page*

Once data has been extracted from the database and is displayed on the page, the following options are used to manipulate data on Monitoring pages:

- **Sort Page Details**
- **Filter Page Details**
- **Search Page Details**
- **Group Page Details**
- **Review Log Details**
Monitoring Page Options

Sort Page Details

1. Click on any column header.
2. Page details are sorted in ascending order by that column. Click on the column header again to re-sort in descending order. Click on the column header a third time to clear the sort order.
   - In the example below, System Status details are sorted by Component Type.

Figure 59 - Sorted Details
**Filter Page Details**

Use the Filter function to display only those records that match specified values.

1. Click the filter icon beside a column header.
2. In the *Filter* pop up window,
   - Check one or more of the values listed to immediately filter details or
   - Enter criteria and operator values and click *Filter*.

*The example below illustrates the filter for the Component Status column on the System Status page.*

*Figure 60 - Filter pop up*
3. Page details are refreshed with only those records that match the selected criteria.
   - *In this example, the System Status page is refreshed to only display records with Started Component Status, as selected in the filter.*

*Figure 61 - Filtered Details*

![Filtered Details Diagram]

4. Click **Clear Filter** to remove the filter and refresh the page.

5. Alternatively, expand the Filter area at the top of the page, enter the desired filter criteria and click the **Run Query** button. The query results are displayed in the grid portion of the page. Click the **Filter Reset** button to clear the filter fields. The **Filter Applied** message indicates that the search results are currently filtered.

*Figure 62 - Filter Criteria*
**Search Page Details**

Use the Search function to search for records with a specific value.

1. In the Search box, at the top of the page, enter a search value.

   The search is automatically applied as each keystroke is entered in the Search box.

2. Page details are refreshed with only those records that contain the search text.
   - The example below illustrates search results for “context.txt” on the Job Status page.

   *Figure 63 - Search Results*

3. Click the X in the Search box to clear the search and re-display the page.

**Group Page Details**

Use the Group function to group log details by specific columns.

1. Drag a column header to Grouped By.

   *Figure 64 - In this example, the column header Component Type is dragged to the group area*
Log details are grouped by the column selected.

**Figure 65** - This example illustrates the same log details as above grouped by **Component Type**.

2. Drag multiple columns to enable sub-grouping.
   - Log details are grouped by the first group column selected. Within that group, details are grouped by the next column selected.

**Figure 66** - In this example, log details are grouped first by Component Status and then by Component Type.
3. Click the X in a column name in the group area to remove grouping by that column.

Figure 67 - Grouped By

Review Log Details
Log details may extend to multiple pages.

- The current page number and total number of records retrieved are displayed at the bottom right of the page.
- Use the page selector, displayed at the bottom left of the page, to select the first, previous, next or last page of log details.
Job Status

Job Status provides detailed information about each job submitted and uses this information to troubleshoot in the event that a document fails to be converted.

The Job Status page, accessed from the Monitoring tab, provides a search criteria area where search details are defined and an execute search arrow to query the database for job information based on criteria specified. Search results are displayed in the grid portion of the page. To reset the filter criteria, click the Reset button to the left of the Execute Search arrow.

Figure 68 - Job Status Page

- An Export option is available to export Job Status to Excel spreadsheet format.
- A Problem Submission option collects information about selected jobs and packages it into a file that can be submitted to Adlib Support to expedite issue resolution.
- The Job ID parameter provides a link to System Log entries related to that job. This is used to determine whether a system Component was the reason that a Job Id did not successfully complete. Job ID can also be used as a filter criteria to quickly find the results of one job.
### To Search Jobs

1. Click the Search Criteria Filter down-arrow at the top of the Job Status page.
2. Enter the **Start Date** and **End Date**, or click the calendar icon and select dates from the calendar pop-up.

*Figure 69 - Search Calendar*

3. Enter additional search criteria, as required:
   - **Job Id**,
   - **Document Name**,
   - **Source**, selected from a drop-down list,
   - **Job Status**, selected from a drop-down list.

4. Drag the **# Records to Return** slider to limit the number of records returned in the search results.

*Figure 70 - Search Criteria*

5. Click the green arrow to execute the query based on search criteria. Search results are displayed. Click the **Reset** button to the left of the **Execute Search** arrow to reset the filter criteria.
Job Status Page

Job Status lists all jobs meeting the criteria selected. For each job, the following details are displayed:

<table>
<thead>
<tr>
<th>Job Status Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed On</td>
<td>Date and time when job completed.</td>
</tr>
<tr>
<td>Environment Name</td>
<td>Name of Environment to which the Component is assigned.</td>
</tr>
<tr>
<td>Job Id</td>
<td>Unique identification assigned to each job. Links to System Log page with log entries filtered for this Job Id only.</td>
</tr>
<tr>
<td>Priority</td>
<td>Run priority assigned to the job, where 1 is the highest priority and will be run before other jobs with a lower priority.</td>
</tr>
<tr>
<td>Started On</td>
<td>Date and time when job started.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates status of job, as:</td>
</tr>
<tr>
<td></td>
<td>- Uninitialized - job has been requested but not yet accepted by the system.</td>
</tr>
<tr>
<td></td>
<td>- Initialized - job has been accepted by the system and processing is pending.</td>
</tr>
<tr>
<td></td>
<td>- Committed - job is committed and ready for processing.</td>
</tr>
<tr>
<td></td>
<td>- Ready - the job ticket has been generated and the job has been queued for processing.</td>
</tr>
<tr>
<td></td>
<td>- Processing - the Transformation Engine is currently processing the job.</td>
</tr>
<tr>
<td></td>
<td>- Completed Successful - job executed successfully from end to end.</td>
</tr>
<tr>
<td></td>
<td>- Completed Failed - a failure occurred at some point during job execution that caused the job to fail.</td>
</tr>
<tr>
<td></td>
<td>- Completed / Resubmission Failed - where configured, jobs may be resubmitted by the Job Manager if they fail. After a specified number of failed tries, the job is flagged with this status.</td>
</tr>
<tr>
<td></td>
<td>- Completed Cancelled - a request was made to cancel the job, and it was successfully cancelled.</td>
</tr>
<tr>
<td></td>
<td>- Completed Uncommitted - either the job failed before it reached the committed state or the job was submitted but not committed by the user.</td>
</tr>
<tr>
<td></td>
<td>- Completed JAR Rejected - the job was rejected by the Job Acceptance Rules (JAR) applicable to that job.</td>
</tr>
</tbody>
</table>

Updated On          | Date and time of last heartbeat update. |

Job Status Details

Click the plus sign beside a job row to expand Job Status details, listed under four tabs:

Figure 71 - Job Status Details

![Job Status Details Diagram]
Component Tab

The Component tab provides details on the **Submitter** *(typically, the Connector that submitted the job)*, **System Manager** and **Transformation Engine** Components.

<table>
<thead>
<tr>
<th>Job Status Component Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submitter Component Type</td>
<td>Category to which the Submitter Component belongs.</td>
</tr>
<tr>
<td>Submitter Install Path</td>
<td>Location where the Submitter Component is installed.</td>
</tr>
<tr>
<td>Submitter Machine Name</td>
<td>Machine on which the Submitter Component resides.</td>
</tr>
<tr>
<td>System Manager Install Path</td>
<td>Location where the System Manager Component is installed.</td>
</tr>
<tr>
<td>System Manager Machine Name</td>
<td>Machine on which the System Manager Component resides.</td>
</tr>
<tr>
<td>Engine Install Path</td>
<td>Location where the Engine Component is installed.</td>
</tr>
<tr>
<td>Engine Machine Name</td>
<td>Machine on which the Engine Component resides.</td>
</tr>
</tbody>
</table>

Job Tab

The Job tab provides details on how the job flowed through the system. It identifies, for example, the Rules that were executed to create the job.

*Figure 72 - Job Tab*

Click the **Job Processing** button to view the Job Processing log in an XML Visualizer in either **Treeview** or **Source** format.

The Details Window can be enlarged by dragging the green triangle in the bottom right corner of the window. Right-click an item in the treeview for more options such as expand, collapse, or copy.
Click the **Job Ticket** button to view the Job Ticket used by the Transformation Engine to process the job in an XML Visualizer in either **Treeview** or **Source** format. The **Details Window** can also be enlarged by dragging the green triangle in the bottom right corner of the window. A search function is available in the **Source** tab.

**Job Documents**

The **Job Documents** tab identifies the **Document Name(s)** processed in the job.
Engine

The *Engine* tab displays job completion details:

<table>
<thead>
<tr>
<th>Job Status Engine Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Start Time</td>
<td>Date and time job started.</td>
</tr>
<tr>
<td>Engine Complete Time</td>
<td>Date and time job completed.</td>
</tr>
<tr>
<td>Job Completion Code</td>
<td>Job completion return code received from the engine.</td>
</tr>
<tr>
<td>Job Completion Description</td>
<td>Job completion return text received from the engine.</td>
</tr>
<tr>
<td>Job Completion Detail</td>
<td>Job information details received from the engine.</td>
</tr>
</tbody>
</table>

**To Link to System Log**

1. Click on a **Job Id** field in the results on the *Job Status* page.
2. Adlib PDF navigates directly to the *System Log* filtered to display all records with the selected **Job Id**.

*Figure 75 - Job Id link to System Log*
To Export Job Status

Use the Export function to export *Job Status* to Excel spreadsheet format.

1. Click **Export**.
2. When prompted, enter a **File name** and browse to a file location.
3. Click **Save**. A status message confirms if the Export was successful.

*Figure 76 - Job Status Spreadsheet*
System Status

*System Status* identifies the health status, or heartbeat, of all Components in Adlib PDF. Components can be running on various machines across the network.

The *System Status* page, accessed from the Monitoring tab, provides an **Alarm Acknowledged** indicator to acknowledge Component status alarms. An **Export** option is available to export *System Status* to Excel spreadsheet format.

*Figure 77 - System Status Page*
**System Status Page**

For each system Component, the *System Status* identifies the following parameters:

<table>
<thead>
<tr>
<th>System Status Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Acknowledged</td>
<td>Indicates user acknowledgement of status alarm. When checked, the alarm on the System Status Overview on the <em>Home</em> page stops flashing, signifying acknowledgment.</td>
</tr>
<tr>
<td>Component Status</td>
<td>Indicates status of Component, as:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Faulted</strong> - Component sent fault error</td>
</tr>
<tr>
<td></td>
<td>- <strong>Initialized</strong> - Component is initialized but is not completed starting</td>
</tr>
<tr>
<td></td>
<td>- <strong>Installed</strong> - Component is installed but has never been started</td>
</tr>
<tr>
<td></td>
<td>- <strong>Stalled</strong> - Component has stopped heartbeating</td>
</tr>
<tr>
<td></td>
<td>- <strong>Started</strong> - Component is started and working</td>
</tr>
<tr>
<td></td>
<td>- <strong>Stopped</strong> - Component has been stopped</td>
</tr>
<tr>
<td></td>
<td>- <strong>Uninstalled</strong> - Component has been uninstalled</td>
</tr>
<tr>
<td>Component Type</td>
<td>Identifies the category to which the Component belongs, as:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Documentum Connector</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Folder Connector</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Generic Connector</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Job Management Service</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Process Manager</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Services</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>SharePoint Workflow Connector</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>System Manager</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Transformation Engine</strong></td>
</tr>
<tr>
<td>Environment Name</td>
<td>Environment to which the Component is assigned.</td>
</tr>
<tr>
<td>Install Path</td>
<td>Location where the Component is installed (e.g. C:\Program Files\Adlib&lt;InstallFolder&gt;).</td>
</tr>
<tr>
<td>Log Level</td>
<td>Identifies the type of log message, by level of severity:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Trace</strong> - Highly detailed information that indicates all activities performed by the system as it executes, useful for troubleshooting complex issues.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Debug</strong> - Moderately detailed information of a technical nature, typically useful for troubleshooting the root cause of key issues.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Info</strong> - Provides information on a successful action taken by the system, or on items that may be of interest to the end user. May also provide some error details if a failure occurs.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Warning</strong> - Indicates that a possible issue may exist, but the system was able to continue processing.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Error</strong> - Indicates that an error occurred while processing that prevented the system from continuing the current process; however, the system recovered.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fatal</strong> - Indicates that an error occurred while processing, from which the system could not recover.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Machine on which the Component is installed.</td>
</tr>
<tr>
<td>Started On</td>
<td>Date and time when Component started.</td>
</tr>
</tbody>
</table>
The Component Status of the Job Management Services may appear as “Stalled” if a sizable amount of time passes between jobs, even though the Components remain functional.

**System Status Details**

Click the plus sign beside a Component row to expand *System Status* details.

**Figure 78 - System Status Details**

<table>
<thead>
<tr>
<th>System Status Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout Interval(s)</td>
<td>Interval, in minutes, between heartbeats.</td>
</tr>
<tr>
<td>Updated On</td>
<td>Date and time of last heartbeat update.</td>
</tr>
</tbody>
</table>

- The *Init Data* tab provides Component initialization information. It identifies the Settings the Component used to initialize itself at start up. Incorrect Settings can lead to unexpected system behavior.

**Changing Component Log Levels**

By default, Adlib PDF is set to "Debug on Error". This is a log setting that will create debug error logs for each job that is processed, but will then remove all the log information below a specified threshold (e.g. Info only) if no errors occur during processing. Information level logs are retained for successful jobs.
In the case where a job completed successfully but still produced unexpected results, it may be useful to temporarily increase the level of logging of successful jobs in order to troubleshoot various aspects of the processing of the job. For more information about changing log levels, see How Do I Change Logging Levels?

To Change Component Log Levels

1. Double-click within the Log Level column for the desired Component and select a new log level.
2. Rerun the job and view the modified Job Status log on the Monitoring page.

Figure 79 - Change Component Log Levels
To Export System Status

Use the Export function to export System Status to Excel spreadsheet format.

1. Click Export.
2. When prompted, enter a File name and browse to a file location.
3. Click Save. A status message confirms if the Export was successful.

Figure 80 - System Status Spreadsheet

To Assign a Friendly Name to a Component

Components can be assigned “friendly names” to assist the user in differentiating among multiple components installed on the same machine.

1. Within the Component Name column, click twice on the name of the Component to be changed to enable it for editing.
2. Type the Friendly Name. Repeat as necessary to rename additional Components.
3. Click the Component Name column header to sort by the Component list by name.

Figure 81 - Assign a Component Friendly Name
**System Status Overview**

The *System Status Overview*, displayed on the *Home* page, visually identifies the health status of Adlib PDF Components. Each box in the *Overview* represents a Component category.

*Figure 82 - System Status Overview*

---

**Connectors**

Connector Components monitor Sources for content. They submit the content as jobs to Adlib PDF and receive completed job output. When these Components are inoperative, new jobs will not be initiated from Sources.

**Services**

This is a layer of WCF-based (Windows Communication Foundation) services used primarily by the Management Console. Job Management Service is a set of web service calls that permit external integration with Adlib PDF.

**System Managers**

System Manager Components manage jobs received via web services and are responsible for monitoring the health of all Components and issuing alerts.

**Engines**

Engine Components perform the transformation of files. When these Components are inoperative, jobs may still be received and queued by the system, but will not be completed until one or more Engines become available.
**Process Managers**

Process Manager Components control individual processes on a single machine within Adlib PDF. There is one Process Manager Component on each machine on which Adlib Components are installed. Process Managers start, stop, monitor and restart the processes assigned to it.

**System Status**

The System Status box identifies the overall status of Adlib PDF. When alarms are issued, this box will be flagged with a warning.

**System Status Component Links**

Clicking on a Component box in the System Status Overview opens the System Status page, filtered to display status information for the selected Component category.

*Figure 83 - In this example, clicking on the Services box displays the System Status page filtered to show Service Components only.*
Alarms

When an Adlib PDF Component is in an alarm state (e.g. faulted, stalled), it is flagged on the System Status Overview with a flashing warning indicator.

- Clicking on a Component box in the Overview opens the System Status page, filtered to display information about the selected Component.
- When alarms are acknowledged on the System Status page, the warning indicator state changes from flashing to solid.
- Once the issue that caused the alarm is resolved, the warning indicator is no longer displayed in the Overview.

To Acknowledge Alarms

1. On the System Status Overview, click on a Component box that displays a flashing warning indicator.
2. The Adlib application opens the System Status filtered for the Component selected.
   For example, if the System Manager Component box displays a warning indicator, clicking on the box opens the System Status page filtered to display System Manager Components only. Filtering is identified in the breadcrumb trail and through highlighted filter icons on Component Type and Component Status columns.
Figure 84 - System Status with Alarm Indicators.

3. Check the **Alarm Acknowledged** parameter to acknowledge the Component alarm. The state of the warning indicator on the **System Status Overview** changes from flashing to solid.

**Figure 85 - System Status Alarm Acknowledged**
System Log

System Log provides event logs from Components within Adlib PDF. The System Log page, accessed from the Monitoring tab, provides a search criteria area where search details are defined and an Execute Search arrow to query the database for system information based on criteria specified. Search results are displayed in the grid portion of the page.

Click the Filter Reset button to clear the filter fields. The Filter Applied message indicates that the search results are currently filtered.

Figure 86 - System Log Page

- An Export option is available to export System Log to Excel spreadsheet format.
- A Problem Submission option collects information about selected System Log entries and packages it into a file that can be submitted to Adlib Support to expedite issue resolution.
To Search System Log

1. Click the Search Criteria Filter down-arrow at the top of the System Log page.
2. Enter the Start Date and End Date, or click the calendar icon and select dates from the calendar pop-up.

Figure 87 - Search Calendar

3. Enter additional search criteria, as required:
   - Job Id,
   - Machine Name, selected from a drop-down list,
   - Log Level, selected from a drop-down list,
   - Document Name,
   - Logger Name, selected from a drop-down list.
   - Component Name, selected from a drop-down list.

4. Drag the # Records to Return slider to limit the number of records returned in the search results.

Figure 88 - System Log Search Criteria

5. Click the green arrow to execute the query based on search criteria. Search results are displayed.
**System Log Page**

For each Adlib PDF event, the System Log identifies the following parameters:

<table>
<thead>
<tr>
<th>System Log Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Context</td>
<td>Name of the document being processed when the event occurred.</td>
</tr>
<tr>
<td>Job Id</td>
<td>Unique identification assigned to each job. Links to Job ID on Job Status page.</td>
</tr>
<tr>
<td>Log Level</td>
<td>Identifies the type of log message, by level of severity:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Trace</strong> - Highly detailed information that indicates all activities performed by the system as it executes, useful for troubleshooting complex issues.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Debug</strong> - Moderately detailed information of a technical nature, typically useful for troubleshooting the root cause of key issues.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Info</strong> - Message that provides information on a successful action taken by the system, or on items that may be of interest to the end user.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Warning</strong> - Message to indicate that a possible issue may exist, but the system was able to continue processing.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Error</strong> - Message to indicate that an error occurred while processing that prevented the system from continuing the current process; however, the system recovered.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fatal</strong> - Message to indicate that an error occurred while processing, from which the system could not recover.</td>
</tr>
<tr>
<td></td>
<td>For more information on changing log levels, see <a href="#">How Do I Change Logging Levels?</a></td>
</tr>
<tr>
<td>Logger Name</td>
<td>Name assigned to the logger module.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Name of the machine on which the event occurred.</td>
</tr>
<tr>
<td>Message</td>
<td>Log entry message.</td>
</tr>
<tr>
<td>Occurred On</td>
<td>Date and time when the event occurred.</td>
</tr>
</tbody>
</table>

**System Log Details**

Click the plus sign beside an event row to display associated information, listed under three tabs:

- The **Full Message** tab displays the entire log entry.

*Figure 89 - System Log Full Message*

- The **Exception** tab displays detailed exception data (if any). Typically for errors only.
- The **Stack Trace** tab displays the call stack to help technical support identify where in the code the log entry was generated.
To Export System Log

Use the Export function to export the System Log to Excel spreadsheet format.

1. Click Export.
2. When prompted, enter a File name and browse to a file location.
3. Click Save. A status message confirms if the Export was successful.

Figure 90 - System Log Spreadsheet

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machine Name</td>
<td>Log Name</td>
<td>Occurred On</td>
<td>Log Level</td>
<td>Message</td>
<td>Sequence</td>
</tr>
<tr>
<td>2</td>
<td>ADN8X0018</td>
<td>TEST_HARNESS</td>
<td>2010-11-18</td>
<td>5:02</td>
<td>Error</td>
<td>29</td>
</tr>
<tr>
<td>3</td>
<td>ADN8X0018</td>
<td>TEST_HARNESS</td>
<td>2010-11-18</td>
<td>5:02</td>
<td>Error</td>
<td>28</td>
</tr>
<tr>
<td>4</td>
<td>ADN8X0018</td>
<td>TEST_HARNESS</td>
<td>2010-11-18</td>
<td>5:02</td>
<td>Error</td>
<td>27</td>
</tr>
<tr>
<td>5</td>
<td>ADN8X0018</td>
<td>TEST_HARNESS</td>
<td>2010-11-18</td>
<td>5:02</td>
<td>Error</td>
<td>26</td>
</tr>
<tr>
<td>6</td>
<td>ADN8X0018</td>
<td>TEST_HARNESS</td>
<td>2010-11-18</td>
<td>5:02</td>
<td>Error</td>
<td>25</td>
</tr>
<tr>
<td>7</td>
<td>ADN8X0018</td>
<td>TEST_HARNESS</td>
<td>2010-11-18</td>
<td>5:02</td>
<td>Error</td>
<td>24</td>
</tr>
<tr>
<td>8</td>
<td>ADN8X0018</td>
<td>TEST_HARNESS</td>
<td>2010-11-18</td>
<td>5:02</td>
<td>Error</td>
<td>23</td>
</tr>
<tr>
<td>9</td>
<td>ADN8X0018</td>
<td>TEST_HARNESS</td>
<td>2010-11-18</td>
<td>5:02</td>
<td>Error</td>
<td>22</td>
</tr>
</tbody>
</table>
Appendix A: Frequently Asked Questions

Overview
This section provides answers to common questions regarding the configuration and operation of Adlib PDF, including:

- What Are the Stages of Job Processing?
- How Do I Configure Adlib PDF for High Availability?
- How Do I Find Out Why My Job Failed?
- What Do I Do if a Component is Generating an Alarm?
- Why Can I Not Process Any Jobs?
- How Do I Change Logging Levels?
- How Do I Get Rid of the Input File Extension in the Rendered PDF?
- How Do I Change the Input File Destination After Job Processing?

What Are the Stages of Job Processing?
The process of document transformation begins when a Connector detects input in a Source repository that it is monitoring. When a new job becomes available, the Connector extracts the metadata content from the Source and submits it to the Job Management Service. The Job Management Service submits the accepted job to the database.

The System Manager is constantly polling the database for jobs it can process. When a new job is detected, the System Manager evaluates the Transformation rules associated with the content from that Source, creates a job ticket and submits the ticket to the database. The Transformation Engine picks up the job, performs the transformation according to the job ticket and writes the completed job back to the database. The Connector, which has been polling the database for completed jobs, uploads the transformed job into the Source output folder or repository.

In addition to the Components that perform content transformation, Adlib PDF contains a Process Manager whose role it is to stop, start and monitor the Transformation Engine, Connector(s) and System Manager. The System Manager also monitors the health of Adlib PDF Components and reports alerts to the system administrator.

Job Processing
When a job is processed by Adlib PDF it proceeds through many identified states as it is handled by different Components:

- **Initialized**: A Connector detects that new input is available in a Source repository that it is monitoring. The Connector extracts the content from the Source, submits it to the Job Management Service, and flags the job as Initialized.

- **Committed**: The Job Management Service evaluates the associated Job Acceptance rule(s) and submits the accepted job to the database in a committed state.
- **Ready**: When a committed job is detected in the database by the System Manager, it prepares the job by evaluating the Transformation rules associated with the content from that Source. Based on that information, it creates a job ticket, submits the ticket to the database, and puts the job in the ready state in the database.

- **Completed**: The Transformation Engine picks up the ready job, performs the transformation according to the job ticket, and writes the completed status back to the database. The Connector, which has been polling for completed jobs, uploads the transformed job into the Source output folder or repository.
How Do I Configure Adlib PDF for High Availability?

Adlib PDF can easily be configured to run on multiple servers in order to add processing capacity, load balancing capabilities, redundancy, or to fill other business requirements. Using the Custom installation process, users can install only the Components they wish to add to the system on a given machine, such as a Transformation Engine, while maintaining control of the entire system from the Management Console.

By adding additional servers to Adlib PDF, the system can be configured to ensure that processing capacity is always available for high priority jobs, without interrupting the flow of normal operations. In the same way, a multi-server system could be configured to route only large jobs to a specific server, while balancing the remainder of work over the other servers.

System redundancy can be achieved by installing multiple Components that perform the same function on additional servers. This configuration is easily managed through modifications to the Process Manager settings.

Each Component, no matter which machine it has been installed on, is monitored by the Management Console. This benefit of Adlib PDF provides for easier troubleshooting, in that users do not have to remotely log into various servers to find the appropriate log file when there is an issue, and with all error logs consolidated in one place, it is easier to determine if a problem is system or job related.

Configuring System Settings

Multi-server installations require minimal additional configuration in order to function within the system. If a user merely wishes to add processing capacity, no additional settings are required once the servers have been installed, however, if a user wishes to allow for Priority job processing or load balancing in some other fashion, the Transformation Engines must be labeled using Environmental System Settings (or “Initialization Settings”) so that jobs can be routed to the appropriate server during processing.

If multiple Components have been installed, changes may also be required to the Process Manager Component, depending on the configuration of the system.

For more information on configuring Adlib PDF to suit your unique business requirements, please Contact Adlib.
How Do I Find Out Why My Job Failed?

Adlib PDF provides a mechanism for Component health monitoring, troubleshooting, system and job logging, and performance reporting. Job and system information is collected in a central database to capture vital system statistics and facilitate logging.

The Job Status page provides detailed information about each job submitted; this information can be used to troubleshoot in the event that an unexpected result is returned. The database can be queried for job information based on the specified search criteria. The Search results are displayed in the grid portion of the page.

The most common results of job processing include:

- **Completed Successful**: Job executed successfully from end to end. Note: A "Successful" status does not mean that all rules gave the expected result. For example, a successful job may fail to retrieve an incorrectly spelled variable or fail to apply a rule because rule conditions were configured incorrectly. In these cases, viewing the logs may be useful to determine which rules were applied and how they were evaluated for a particular job.

- **Completed Failed**: An issue occurred at some point during job execution that caused the job to fail. The Transformation Engine received the job, but could not successfully complete the job processing.

- **Completed JAR Rejected**: The job was rejected due to the evaluation of a Job Acceptance Rule.

**Figure 91 - Job Status Page**

**Viewing Job Processing Logs**

A Job Processing Log is created for each job, and can contain varying amounts of data depending on the log levels that are set for each Component. If a job produces unexpected results, it can be helpful to review the sections of the log related to rule processing and the input values that are passed in with the document.

**To Access and Review Job Processing Logs:**

1. Navigate to the *Job Status* tab and expand the job you wish to view.
2. To view the log, click the Job tab, then click the Job Processing button.

**Figure 92 - Job Processing Log Button**

3. The log will be displayed in an XML Visualizer, in either a Treeview or Source format.

4. On the Source tab, to locate Job Acceptance rule processing details, search for the section beginning with "Process Jar Result".

   In the log sample below:
   - The Rule Condition defined for a File Size Job Acceptance Rule is evaluated (does file size exceed 3Mb?) as true, therefore
   - The Rule Setting is applied (Accepted = false)

**Figure 93 - Job Acceptance Rule Evaluation**

5. To locate Transformation Rule processing details, search for the section beginning with "Rule Results".

6. In the log sample below,
   - The Rule Condition defined for a Watermark rule is evaluated (does the Source ID = Confidential (numeric value equivalent)?) as true, therefore
   - The Rule Setting is applied (watermark text = Confidential)
If the Job has failed due to an issue with a Component, it may be helpful to review the System Logs created during the job processing.

To Observe System Logs for a Completed Job:

1. Navigate to the Job Status page and click the link in the Job Id column that corresponds to the completed job you wish to investigate.

TIP

The Job Id is a unique GUID that is generated for each job.
2. The **System Log** page opens, pre-filtered with results from the job identified by Job Id. The Logger Name column lists messages from each Component as the job passed through the system.

*Figure 96 - System Log - Filtered by Job Id*

3. Observe the entries as the job flows from Source Input to Source Output (or failure).
What Do I Do if a Component is Generating an Alarm?

When an Adlib PDF Component is in an alarm state (e.g. faulted, stalled), it is flagged on the System Status Overview with a flashing warning indicator.

- Clicking on a Component box in the Overview opens the System Status page, filtered to display information about the selected Component.
- When alarms are acknowledged on the System Status page, the warning indicator state changes from flashing to solid.
- Once the issue that caused the alarm is resolved, the warning indicator is no longer displayed in the Overview.

*Figure 97 - System Status with Alarm Indicators.*
To Acknowledge Alarms
1. On the System Status Overview, click on a Component box that displays a flashing warning indicator.
2. Adlib PDF opens the System Status filtered for the Component selected.
   For example, if the System Manager Component box displays a warning indicator, clicking on the box opens the System Status page filtered to display System Manager Components only.

Component Status
The status of each Adlib PDF Component can be viewed on the System Status tab on the Monitoring Page.

Figure 98 - System Status

A Component can have any one of the following statuses:
- **Faulted** - Component has sent a fault error
- **Initialized** - Component is initialized but has not completed starting
- **Installed** - Component is installed but has never been started
- **Stalled** - Component has stopped heartbeating
- **Started** - Component is started and is working
- **Stopped** - Component has been stopped
- **Uninstalled** - Component has been uninstalled
The Component Status of the Job Management Services may appear as “Stalled” if a sizable amount of time passes between jobs, even though the Components remain functional.

**Restarting Process Manager**

A Component that is in *Installed* or *Stopped* status can usually be restarted by restarting the **Process Manager Service**.

**To Restart Process Manager:**

1. Select **Control Panel** from the Windows Start menu, then open **Administrative Tools/Services**. Select the **Adlib Process Manager Service**, and click **Restart the Service**.

![](image)

**Figure 99 - Restart Process Manager**

**Viewing System Logs**

If restarting **Process Manager** does not bring the affected Component back to a “Started” status, it may be helpful to view the System logs for that Component. For more information on accessing System Logs, see **How Do I Find Out Why My Job Failed?**
Why Can I Not Process Any Jobs?

The Transformation Engine must be properly licensed before jobs can be processed. An expired or unlicensed Engine will show an "Initialized" status, and cannot be restarted with the Process Manager Service. Use the License Manager application, which is accessed from the Adlib PDF Start Menu group, to view existing licenses and perform various licensing functions.

*Figure 100 - Adlib License Manager*

See the Adlib PDF Installation Guide for instructions on using the License Manager. For more information on your specific license needs, contact Adlib.
How Do I Change Logging Levels?

Adlib PDF can generate many levels of logging detail for job processing and system functions. Logs can be useful in many ways; a job processing log will show not only which rules were evaluated for the job, but also the order that the rules were processed in, the metadata values that were passed in with the document, and the results of each interaction with the Adlib Components. Likewise, Adlib PDF Component logs can be used to monitor processing capacity, load balancing, and if necessary, track and identify system problems across the entire system.

By default, Adlib PDF is set to “Debug on Error”. This is a log setting that will create debug error logs for each job that is processed, but will then remove all the log information below a specified threshold (e.g. Info only) if no errors occur during processing. Information level logs are retained for successful jobs.

In the case where a job completed successfully but still produced unexpected results, it may be useful to temporarily increase the level of logging of successful jobs in order to troubleshoot various aspects of the processing of the job. For more information about job processing logs, see How Do I Find Out Why My Job Failed?

To change logging levels, the log level defaults must be changed for both the System Manager and Job Management Service Components and the job re-run before the new logs can be viewed.

 vowed To Change Logging Levels:

1. Log in to Adlib PDF and navigate to the System Settings page and select System Manager from the Environment Configure menu.

2. In the Rule Set Editor, click the Edit tab to enable editing of the rule settings.
3. Select **Edit** in the SystemManager/Settings rule **Edit** menu.
4. In the **Completed Job Log Retention** section, select an alternate logging level from the drop-down lists in the **On Error** and/or **On Success** fields and click **OK**.

**Figure 102 - Logging Threshold Settings**

5. Click **Save** in the **Rule Set Editor**.
6. Click the **System Settings** tab again to navigate back to the **Environment** page and repeat this process in the Adlib.JobManagementService.Settings rule for the **Job Management Service** Component.
7. Navigate to the **Environment** page again and select **Publish** from the **Edit** menu to activate the changes to the Components.
8. Navigate to the **Monitoring** tab and click the **System Status** button.
9. Double-click the **Log Level** value for each Component and select the new log level (e.g. **Trace**) from the drop-down list.
10. Re-run the job and view the modified Job Status log on the Monitoring page.

How Do I Get Rid of the Input File Extension in the Rendered PDF?

By default, when using Folder Connector to submit jobs, the input file extension is retained in the rendered output file. The extension can be removed by modifying the Folder Connector Behavior System Setting and instructing the system to retain only the Input Base File name within the processed job name.

**To Modify the Output File Name:**

1. Click the System Settings tab and select Folder Connector from the Environment Settings menu.
2. Select the Edit tab to enable the Rule Set Editor.
3. Select Edit on the Folder Connector/Behavior Rule Setting Edit menu.
4. In the Edit Behavior Rule Setting window, expand the Job Files section then expand Output.
5. Select the **Naming** checkbox, then click the **Metadata** button.

6. In the **Metadata Selector** window, expand **Variables Submitted with Jobs**, then expand **FolderConnector**.

7. Select **Adlib.Connectors.InputBaseFileName** and click **Insert Selection**.
8. Click **OK**.
9. Click **Save** in the *Rule Set Editor* to save the Rule Setting changes.
10. Navigate back to the *System Settings* page and select **Publish** from the Environment Action menu to activate the new configuration.
How Do I Change the Input File Destination After Job Processing?

By default, when using **Folder Connector** to submit jobs, the input file is placed in the output folder along with the processed job file, but this configuration can be modified within the Folder Connector Behavior System Setting. Input files can be deleted, moved to the Output folder specified for the Source, or moved to an alternate destination folder once job processing is complete.

**To Modify the Input File Destination After Job Processing:**

1. Click the **System Settings** tab and select **Folder Connector** from the Environment Settings menu.
2. Select the **Edit** tab to enable the **Rule Set Editor**.
3. Select **Edit** on the Folder Connector/Behavior Rule Setting Edit menu.
4. In the **Edit Behavior Rule Setting** window, expand the **Job Files** section then expand **Input**.
5. Select the **Handling** checkbox, then select the desired Handling Option.

*Figure 106 - Input Handling Options*

6. Click **OK**.
7. Click **Save** in the **Rule Set Editor** to save the Rule Setting changes.
8. Navigate back to the **System Settings** page and select **Publish** from the Environment Action menu to activate the new configuration.
Appendix B: Database Growth Management

Database Growth Management settings are included with Adlib PDF to assist the user in controlling database growth as a result of the job information that is retained during the operation of the system.

SQL Express 2008 is installed automatically with Adlib PDF Express.

When logging in Info mode, approximately 200KB of job information will be retained per successful job. Unsuccessful jobs and/or higher logging levels may retain additional information, requiring up to 3-4x as much space in the database.

Database Growth Management Modes

Database Growth Management runs in two modes:

**Mode 1: Default**

Since SQL Express databases have a data size cap (10GB for Express 2008) a mandatory “by-size” cleanup will be performed when this type of database is detected. Every hour, Database Growth Management will check if the database has reached 80% of capacity. If it has, enough records will be purged to reduce the size to 50% of capacity. This is an automatic function and is not configurable.

**Mode 2: User-Defined**

The user can optionally configure a “by-age” cleanup. This process runs once a day and purges any job information that is older than the configured age. If this option is configured, the Database Growth Management procedure will purge jobs and any associated child records older than 90 days at 2:00am local time.

When configuring the Database Growth Management settings, the following formula can be used to determine the minimum disk space required relative to the time elapsed between database cleanup procedures:

\[
200 \text{ KB} \times \text{Average Number of Active Jobs in the Adlib System} = \text{Estimated Database Growth Per Day}
\]

Once the minimum disk space has been determined, the default settings for Database Growth Management can be adjusted relative to the speed at which the disk space will be used up, based on the number of jobs run through Adlib PDF.
For example, if 1,000 jobs are run through the system a day, the estimated minimum disk space required will be approximately 195MB per day. By default, Database Growth Management will perform a cleanup procedure once per day, and will purge any job information that is older than 90 days. Using the calculations in this example, the database will have grown approximately 17GB in that time. If the default rate of database cleanup is not sufficient, the settings can be configured to suit the needs of the user.

For more information on adjusting these settings, see To Configure Database Growth Management Settings.

Database Tables
The following tables are involved in the cleanup process:
- SRT_JOB_ARCHIVE
- SRT_JOB_DOCUMENT_ARCHIVE
- SRT_JOB_GROUP
- ELS_LOG_ENTRY
- ELS_STATISTIC_ENTRY

Any records in the ELS tables associated with a purged job will be purged themselves (the JOB_CONTEXT field is checked for the association). Additionally, any unassociated records in these tables (null/empty JOB_CONTEXT field) older than the purged job will also be removed. Therefore the database will never retain any ELS records older than the most recently purged job.

Configuring Database Growth Management Settings

To Configure Database Growth Management Settings:
The following Adlib System Manager settings control the timing and age of the records effected by the Database Growth Management cleanup procedure:

- **Record Cleanup Age**: The age in days of job and log records to clean up.
- **Run Cleanup Time**: The hour of the day in local time (0-23) in which the cleanup will run.

The default settings can be modified to suit the needs of the user using the following procedure:

1. In the Adlib Management Console, navigate to the Systems Settings page.
2. Select **System Manager** from the Environment **Configure** Menu.

*Figure 107 - Environment Settings Menu*

3. In the **Rule Set Editor**, select the **Edit** tab.

4. Select **Edit** from the **Edit** menu of the System Manager/Settings Rule Setting.

5. In the Database Growth Management section, enter the desired age (in days) of archived jobs to be retained in the database in the **Record Cleanup Age** field.

6. Specify the desired time to run the database cleanup by entering the number associated with the hour of the day in local time (0-23) in the **Run Cleanup Time** field.
7. Click **OK**. Click **Save** in the **Rule Set Editor**.

8. To activate the changes made to the **System Manager** Rule Settings, navigate back to the **Environment** tab on the **System Settings** page. A green caution symbol indicates that unpublished changes have been detected. Click the symbol to publish the changes.
Appendix C: Content Transformation Viewers and Supported File Types

Adlib PDF provides automated document conversion of over 300 file types to PDF, Text, and Image. During content rendering, the Transformation Engine uses a “viewer” in preparation for transformation to the specified format. In order to select the appropriate rendering viewer, the Transformation Engine must first identify the file type being converted by reading the header and/or the file extension. Once the file type has been identified, the document is rendered and output to the format specified in the Rule Setting.

Native Application Support (NAS)

Adlib PDF supports native applications (e.g. Microsoft Excel) as viewers which are used to render their associated document types (e.g. xls) during the transformation process. This method ensures the highest rendering accuracy and is recommended for complex documents such as word processing files that contain tables, graphics, etc. In order to ensure the best quality output, it is recommended that all native applications be installed on the Transformation Engine servers that will process those files.

Although it is not strictly necessary, for more precise control of document rendering the user can include a “native application viewer-specific” Rule Setting within the Instruction Set that will be used to process those file types. These Rule Settings control attributes that are specific to the native application viewer and affect how the associated file types will be rendered.

For example, using the Rule Setting “ConvertToPdf/MicrosoftWord”, the user can control elements such as the compression of images, the embedding of fonts, and the creation of content bookmarks.

A list of the Rule Settings associated each supported native application is displayed below.

(Some file types can only be rendered using native application support. See the Supported File Types table for details.)

Supported Native Applications and Associated Rule Settings

This table contains a list of the native applications that are currently supported; additional applications (and versions) are always being added. The level of support is also indicated for each version/format of the application.

The levels of support for native applications include:

<table>
<thead>
<tr>
<th>Level of Support</th>
<th>Definition</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certified (C)</td>
<td>Extensively tested.</td>
<td>This is the recommended version, edition, language, service pack, etc.</td>
</tr>
<tr>
<td>Supported (S)</td>
<td>Known to work, however not subject to the same degree of testing as Certified.</td>
<td>We provide support for these versions, editions, languages, etc., but do not test as thoroughly.</td>
</tr>
<tr>
<td>Partially Supported (P)</td>
<td>Is expected to work. We will provide our best effort to support.</td>
<td>These are versions, editions, languages, etc., that are being phased out by their vendor and/or are limited in functionality.</td>
</tr>
</tbody>
</table>
This table refers to only the English versions of each application. Alternative language versions of these applications are not officially supported by Adlib PDF.

<table>
<thead>
<tr>
<th>Mfr</th>
<th>Application</th>
<th>Version/Format</th>
<th>Support</th>
<th>Category/Rule Setting(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe</td>
<td>Framemaker</td>
<td>6.0</td>
<td>S</td>
<td>ConvertToPdf/AdobeFramemaker</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7.0</td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Corel</td>
<td>CorelDRAW</td>
<td>8.0</td>
<td>S</td>
<td>ConvertToPdf/CorelCorelDraw</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12.0</td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Corel</td>
<td>WordPerfect</td>
<td>8.0 to X5¹</td>
<td>S</td>
<td>ConvertToPdf/CorelWordPerfect</td>
</tr>
<tr>
<td>Ghostscript</td>
<td>Ghostscript</td>
<td>7.04 to 8.15 (32-bit only)</td>
<td>S</td>
<td>ConvertToPdf/GhostscriptExport</td>
</tr>
<tr>
<td>Microsoft</td>
<td>Excel⁴</td>
<td>2003</td>
<td>P</td>
<td>ConvertToHtml/MicrosoftExcelExport</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2007³</td>
<td>C</td>
<td>ConvertToPdf/MicrosoftExcel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2010⁵</td>
<td>C</td>
<td>ConvertToXps/MicrosoftExcelExport</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2013⁵</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Microsoft</td>
<td>InfoPath</td>
<td>2003²</td>
<td>P</td>
<td>ConvertToPdf/MicrosoftInfoPath</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2007</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2010⁵</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2013⁵</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Microsoft</td>
<td>Internet Explorer</td>
<td>7.0</td>
<td>P</td>
<td>ConvertToPdf/MicrosoftInternetExplorer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8.0</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>9.0</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Microsoft</td>
<td>Outlook</td>
<td>2003</td>
<td>P</td>
<td>ConvertToPdf/MicrosoftOutlook</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2007³</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2010</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2013⁵</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Microsoft</td>
<td>PowerPoint⁴</td>
<td>2003</td>
<td>P</td>
<td>ConvertToHtml/MicrosoftPowerPointExport</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2007³</td>
<td>C</td>
<td>ConvertToPdf/MicrosoftPowerPoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2010⁵</td>
<td>C</td>
<td>ConvertToXps/MicrosoftPowerPointExport</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2013⁵</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Mfr</td>
<td>Application</td>
<td>Version/Format</td>
<td>Support</td>
<td>Category/Rule Setting(s)</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------</td>
<td>----------------</td>
<td>---------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Microsoft</td>
<td>WordPad</td>
<td>5.x, 6.x</td>
<td>P, C</td>
<td>ConvertToPdf/MicrosoftWordPad</td>
</tr>
<tr>
<td>Oracle</td>
<td>OpenOffice.Org (Calc, Impress, Writer)</td>
<td>3.0, 3.0.1</td>
<td>C</td>
<td>ConvertToPdf/OpenOffice, ConvertToPdf/OpenOfficeExport</td>
</tr>
</tbody>
</table>

**Native Application Notes:**

1. Internal content hyperlink creation not supported for WordPerfect. X4 and X5 only validated for Windows Server 2003 32-bit environment.
2. Microsoft Office 2003 Service Pack 1 (or greater) required.
4. It is recommended that the Save AutoRecover options within Word, Excel and PowerPoint be disabled.
5. Support is currently available for only the 32-bit versions of Microsoft InfoPath, Word, Excel, PowerPoint, Project and Visio 2010 and all Microsoft Office 2013 applications.
**Adlib Viewer Support**

Adlib viewers are installed with the Transformation Engine and are used to render Text (non-unicode), Images, HPGL, MSG and PDF file types. This method ensures the highest rendering accuracy and efficiency for these document types.

If desired, users can use the File Type-specific Rule Settings to maintain control over specific aspects of the rendering of these file types, however in the absence of these Settings, the Transformation Engine will automatically process these files with an Adlib Viewer using system defaults.

**Adlib Viewer Supported File Types and Associated Rule Settings**

<table>
<thead>
<tr>
<th>Input File Type</th>
<th>Output File Type</th>
<th>Category/Rule Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>HTML</td>
<td>ConvertToHtml/Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>JPEG</td>
<td>ConvertToJpeg/Pdf</td>
</tr>
<tr>
<td>CAD¹</td>
<td>PDF</td>
<td>ConvertToPdf/CAD</td>
</tr>
<tr>
<td>Image²</td>
<td>PDF</td>
<td>ConvertToPdf/Image</td>
</tr>
<tr>
<td>OCR²</td>
<td>PDF</td>
<td>ConvertToPdf/Ocr</td>
</tr>
<tr>
<td>Text (non-unicode)</td>
<td>PDF</td>
<td>ConvertToPdf/Text</td>
</tr>
<tr>
<td>XSL-FO</td>
<td>PDF</td>
<td>ConvertToPdf/XslFo</td>
</tr>
<tr>
<td>PDF</td>
<td>Png</td>
<td>ConvertToPng/Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Text</td>
<td>ConvertToText/Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Tiff</td>
<td>ConvertToTiff/Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Cals</td>
<td>ConvertToCals/Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Gif</td>
<td>ConvertToGif/Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Xps</td>
<td>ConvertToXps/Pdf</td>
</tr>
</tbody>
</table>

**Adlib Viewer Notes:**

1. Requires a CAD license.
2. For a list of all supported Image and OCR input file types see the [Supported File Types](#) table.
**Generic Viewer Support**

The Generic viewer is installed with the Transformation Engine and supports the rendering of hundreds of file types. This method ensures rendering efficiency without requiring additional software to be installed on the computer performing the conversion. The Generic method renders simple documents accurately but may not render complex documents as well as the native application used to create the document. We recommend that customers process a number of documents using both the Generic and NAS methods to identify the method which is most suitable.

The Generic viewer Rule Setting, “ConvertToPdf/Generic” enables users to control the use of embedded fonts and image compression and resolution where required. This setting can also be used to direct Adlib PDF to substitute the Generic viewer for a native application viewer in the case where a native application will not be installed on the Transformation Engine server used to transform the file.

For a list of all file types that are currently supported by the Generic viewer, see the Supported File Types table.

**Supported File Types Table - Levels of Support**

The supported file types table indicates the level of support for the rendering of each version/format of the files, according to the viewer(s) used to process that file.

The levels of support for file formats include:

<table>
<thead>
<tr>
<th>Level of Support</th>
<th>Definition</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certified (C)</td>
<td>Extensively tested.</td>
<td>This format has been extensively tested and you should expect high fidelity.</td>
</tr>
<tr>
<td>Supported (S)</td>
<td>Known to work, however not subject to the same degree of testing as Certified</td>
<td>Every supported file format that is not Certified.</td>
</tr>
<tr>
<td>Partially Supported (P)</td>
<td>Is expected to work. We will provide our best effort to support.</td>
<td>Formats that have known limitations and/or produce a lower level of fidelity.</td>
</tr>
</tbody>
</table>
## Supported File Types

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extensions</th>
<th>Versions/Formats</th>
<th>NAS</th>
<th>Adlib</th>
<th>Generic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Acrobat</td>
<td>PDF</td>
<td>All</td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Adobe FrameMaker</td>
<td>MIF</td>
<td>6.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Adobe FrameMaker</td>
<td>FM</td>
<td>6.0, 7.0</td>
<td></td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Adobe FrameMaker Graphics</td>
<td>FMV</td>
<td>Vector/raster to 5.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Adobe Illustrator</td>
<td>AI</td>
<td>1.0 to 7.0, 9.0, CS3</td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Adobe Photoshop</td>
<td>PSD</td>
<td>4.0, CS3</td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Ami Draw</td>
<td>SDW</td>
<td>Ami Draw</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>ANSI Text</td>
<td>TXT</td>
<td>7 &amp; 8 bit</td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>AutoCAD Drawing Web Format</td>
<td>DWF</td>
<td>2012 and below</td>
<td></td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>AutoCAD Interchange</td>
<td>DXF</td>
<td>2012 and below</td>
<td></td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>AutoCAD Native Drawing</td>
<td>DWG</td>
<td>2012 and below</td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>AutoDesk Inventor</td>
<td>DWG, IAM, IDW, IPT</td>
<td>11 and below</td>
<td></td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>AutoDesk Inventor</td>
<td>DWG, IAM, IDW, IPT</td>
<td>2011, 2012</td>
<td></td>
<td>C. 19</td>
<td>C</td>
</tr>
<tr>
<td>AutoShade Rendering</td>
<td>RND</td>
<td>2.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Bentley MicroStation Drawing</td>
<td>DGN</td>
<td>8.9, 8.5, 8.1, and below</td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Binary Group 3 Fax</td>
<td></td>
<td>All</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Bitmap</td>
<td>BMP, ICO, DIB</td>
<td></td>
<td></td>
<td></td>
<td>C 18</td>
</tr>
<tr>
<td>CADKEY</td>
<td>PRT</td>
<td></td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>CalComp PCI 906/907 Plot</td>
<td>906</td>
<td></td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>CALS Group IV</td>
<td>CAL, CG4, MIL, ODA, C4</td>
<td>Type I, Type II</td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>CAMCAD</td>
<td>CC</td>
<td></td>
<td></td>
<td></td>
<td>P 1</td>
</tr>
<tr>
<td>CIT Intergraph Group IV</td>
<td>CIT</td>
<td>All</td>
<td></td>
<td></td>
<td>P 1</td>
</tr>
<tr>
<td>Computer Graphics Metafile</td>
<td>CGM</td>
<td>ANSI, CALS</td>
<td></td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Computer Graphics Metafile</td>
<td>CGM</td>
<td>4</td>
<td></td>
<td></td>
<td>C 1</td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Corel Clipart format</td>
<td>CMX</td>
<td>5.0 to 6.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Corel Draw</td>
<td>CDR with TIFF header</td>
<td>2.0 to 9.0</td>
<td>S</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Corel Draw</td>
<td>CDR</td>
<td>6.0 to 12.0</td>
<td>S</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Corel/Novell Quattro Pro</td>
<td></td>
<td>1.0 to 12</td>
<td>S</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Corel/Novell WordPerfect</td>
<td>WPD, WP5</td>
<td>1.0 to 12, X3</td>
<td>S</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>DataEase</td>
<td>4.x</td>
<td></td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>dBASE</td>
<td></td>
<td>1.0 to 5.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>dBXL</td>
<td>1.3</td>
<td></td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>DEC WPS Plus</td>
<td>DX</td>
<td>1.0 to 4.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEC WPS Plus</td>
<td>WPL</td>
<td>1.0 to 4.1</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DG Auto-trol Vector</td>
<td>DG</td>
<td></td>
<td></td>
<td></td>
<td>p1</td>
</tr>
<tr>
<td>DisplayWrite 2 &amp; 3</td>
<td>TXT</td>
<td>All</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>DisplayWrite 4 &amp; 5</td>
<td></td>
<td>1.0 to 2.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td></td>
<td>3.0, 4.0, 4.5</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encapsulated PostScript</td>
<td>EPS</td>
<td>TIFF header only</td>
<td>S10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Executable</td>
<td>EXE, DLL</td>
<td></td>
<td></td>
<td></td>
<td>p7</td>
</tr>
<tr>
<td>Extensible Markup Language</td>
<td>XML, XSL</td>
<td>All</td>
<td>C4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Choice</td>
<td></td>
<td>1.0 to 3.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>FoxBase</td>
<td>2.1</td>
<td></td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Framework</td>
<td>3.0</td>
<td></td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Freelance for OS/2</td>
<td></td>
<td>1.0 to 2.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freelance for Windows</td>
<td></td>
<td>1.0 to 9.6</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GEM Paint</td>
<td>IMG</td>
<td></td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphics Environment Manager</td>
<td>GEM</td>
<td>Bitmap &amp; vector</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphics Interchange Format</td>
<td>GIF</td>
<td></td>
<td>C</td>
<td>P18</td>
<td></td>
</tr>
<tr>
<td>GZIP Compression Utility</td>
<td>GZ</td>
<td></td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Harvard Graphics for DOS</td>
<td>2.x, 3.x</td>
<td></td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Harvard Graphics for Windows</td>
<td>PRS</td>
<td>All</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Hewlett Packard Graphics Language</td>
<td>HP, HPGL, HGL, HPG, PLT, 000, HPGL/2</td>
<td></td>
<td></td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Hewlett Packard Graphics Language</td>
<td>HPGL, HPGL/2</td>
<td>C^1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hewlett Packard ME10</td>
<td>CMI, MI</td>
<td>13 and below</td>
<td></td>
<td></td>
<td>P^1</td>
</tr>
<tr>
<td>Hypertext Markup Language</td>
<td>HTM, HTML</td>
<td>1.0 to 3.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Hypertext Markup Language</td>
<td>HTM, HTML, CSS</td>
<td>All</td>
<td></td>
<td>C^3</td>
<td></td>
</tr>
<tr>
<td>IBM FFT</td>
<td></td>
<td>All</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>IBM Graphics Data Format</td>
<td>GDF</td>
<td>1.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>IBM Picture Interchange Format</td>
<td>PIF</td>
<td>1.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>IBM Revisable Form Text</td>
<td></td>
<td>All</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>IBM Writing Assistant</td>
<td></td>
<td>1.01</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Initial Graphics Exchange Specification</td>
<td>IGES</td>
<td>5.2</td>
<td></td>
<td></td>
<td>P^1</td>
</tr>
<tr>
<td>Joint Photographic Experts Group</td>
<td>JPG, JPEG, JPE</td>
<td></td>
<td></td>
<td></td>
<td>P^18</td>
</tr>
<tr>
<td>JPEG 2000</td>
<td>J2K, JP2</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JustSystems Ichitaro</td>
<td></td>
<td>5.0, 6.0, 8.0, 9.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>JustWrite</td>
<td></td>
<td>1.0 to 3.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Kodak Flash Pix</td>
<td>FPX</td>
<td></td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Kodak Photo CD</td>
<td>PCD</td>
<td>1.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Legacy</td>
<td>LEG</td>
<td>1.0 to 1.1</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Lotus 1-2-3 (DOS &amp; Windows)</td>
<td>WK1, WK3, WK4, WK5</td>
<td>1.0 to 5.0</td>
<td></td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>Lotus 1-2-3 (OS/2)</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>Lotus 1-2-3 Charts (DOS &amp; Windows)</td>
<td>WK1, WK3, WK4, WK5</td>
<td>1.0 to 5.0</td>
<td></td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>Lotus 1-2-3 for SmartSuite</td>
<td>WK1, WK3, WK4, WK5</td>
<td>97 to 9.6</td>
<td></td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------</td>
<td>-------------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Lotus AMI/AMI Professional</td>
<td></td>
<td>1.0 to 3.1</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Lotus Manuscript</td>
<td></td>
<td>2.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Lotus Notes</td>
<td>NSF</td>
<td></td>
<td>P8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus PIC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Lotus Snapshot</td>
<td>All</td>
<td></td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Lotus Symphony</td>
<td>1.0, 1.1, 2.0</td>
<td></td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Lotus Word Pro</td>
<td>LWP, MWP</td>
<td>96 to 9.8</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>LZA Self Extracting Compress</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Macintosh PICT1 &amp; PICT2</td>
<td></td>
<td>Bitmap only</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>MacPaint</td>
<td>PNTG</td>
<td></td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>MacWrite II</td>
<td>1.1</td>
<td></td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>MASS11</td>
<td>M11</td>
<td>1.0 to 8.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Micrografx Designer</td>
<td>DRW</td>
<td>1.0 to 3.1</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Micrografx Designer</td>
<td>DSF</td>
<td>6.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Micrografx Draw</td>
<td>DRW</td>
<td>1.0 to 4.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Microsoft Access</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Microsoft Binder</td>
<td>OBD</td>
<td>7.0 to 97</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Microsoft Excel Charts</td>
<td>XLC</td>
<td>2.x to 7.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>XML</td>
<td>2003</td>
<td>S5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>XLS, XLT</td>
<td>2.2 to 2003</td>
<td>C15</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>XLSX, XLTX</td>
<td>2007, 2010, 2013</td>
<td>C14,15</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Microsoft Multiplan</td>
<td></td>
<td>4.0</td>
<td></td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Microsoft Outlook Express Mail Message</td>
<td>EML</td>
<td></td>
<td>C</td>
<td>C</td>
<td>P</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
<td>PPT, PPS</td>
<td>3.0 to 2003</td>
<td>C15</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
<td>PPTX</td>
<td>2007, 2010</td>
<td>C14,15,17</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-------</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
<td>POT</td>
<td>3.0 to 2010</td>
<td>C^15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project</td>
<td></td>
<td>98 Text only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project</td>
<td></td>
<td>2002 to 2010</td>
<td></td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Microsoft Publisher</td>
<td>PUB</td>
<td>2013</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Microsoft Rich Text Format</td>
<td>RTF</td>
<td>All</td>
<td>C^9</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Microsoft Snapshot Viewer</td>
<td>SNP</td>
<td>9.0 to 11</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Microsoft Visio Drawing</td>
<td>VSD</td>
<td>All</td>
<td>C^15</td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Microsoft Visio Drawing</td>
<td>VSDX</td>
<td>2013</td>
<td></td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Microsoft Visio Stencil</td>
<td>VSS</td>
<td>2003 to 2010</td>
<td></td>
<td>C^15</td>
<td></td>
</tr>
<tr>
<td>Microsoft Visio Template</td>
<td>VST</td>
<td>2003 to 2010</td>
<td>C^15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Visio Web Drawing</td>
<td>VDW</td>
<td>2010</td>
<td>C^15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows Write</td>
<td></td>
<td>1.0 to 3.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>XML</td>
<td>2003</td>
<td>S^5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>DOC</td>
<td>1.0 to 2003</td>
<td>C^15</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>DOT</td>
<td>1.0 to 2010</td>
<td>C^15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Works</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Microsoft Works</td>
<td>WPS</td>
<td>1.0 to 4.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MIME HTML</td>
<td>MHT</td>
<td></td>
<td></td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>MIME Text Mail</td>
<td></td>
<td></td>
<td>C</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Mosaic Twin</td>
<td></td>
<td>2.5</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MultiMate</td>
<td></td>
<td>1.0 to 4.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navy DIF</td>
<td></td>
<td>All</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nota Bene</td>
<td></td>
<td>3.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Novell Perfect Works</td>
<td></td>
<td>2.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Novell Perfect Works (Draw)</td>
<td></td>
<td>2.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Novell Quattro Pro for DOS</td>
<td>WB1</td>
<td>1.0 to 5.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Nuance OmniPage/ PaperPort</td>
<td>MAX</td>
<td></td>
<td></td>
<td>C\textsuperscript{11}</td>
<td></td>
</tr>
<tr>
<td>OpenOffice.org Calc</td>
<td>ODS, OTS, SXC, STC</td>
<td>1.0 to 3.0.1</td>
<td>C</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>OpenOffice.org Impress</td>
<td>ODP, OTP, SXI, STI</td>
<td>1.0 to 3.0.1</td>
<td>C</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>OpenOffice.org Writer</td>
<td>ODT, OTT, SXW, STW</td>
<td>1.0 to 3.0.1</td>
<td>C</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Office Writer</td>
<td></td>
<td>4.0 to 6.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>OrCAD</td>
<td>DSN</td>
<td>10</td>
<td></td>
<td>C\textsuperscript{1}</td>
<td></td>
</tr>
<tr>
<td>OS/2 PM Metafile</td>
<td>MET</td>
<td>3.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Paint Shop Pro 6 Win32 only</td>
<td>PSP</td>
<td>5.0 to 6.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Paradox (DOS)</td>
<td></td>
<td>1.0 to 4.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Paradox (Windows)</td>
<td></td>
<td>1.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>PC Paintbrush</td>
<td>DCX, PCX</td>
<td></td>
<td>C</td>
<td>P\textsuperscript{18}</td>
<td></td>
</tr>
<tr>
<td>PC-File Letter</td>
<td></td>
<td>1.0 to 5.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Personal R:BASE</td>
<td></td>
<td>1.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>PFS:Professional Plan</td>
<td></td>
<td>1.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>PFS:Write</td>
<td>A, B, C</td>
<td></td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>PKWARE Archive</td>
<td>ZIP</td>
<td>All</td>
<td></td>
<td>C\textsuperscript{16}</td>
<td></td>
</tr>
<tr>
<td>Portable Bitmap</td>
<td>PBM</td>
<td>All</td>
<td>C</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Portable Graymap</td>
<td>PGM</td>
<td>All</td>
<td>C</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Portable Network Graphics</td>
<td>PNG</td>
<td>1.0</td>
<td>C</td>
<td>P\textsuperscript{18}</td>
<td></td>
</tr>
<tr>
<td>Portable Pixmap</td>
<td>PPM</td>
<td>All</td>
<td>C</td>
<td>P\textsuperscript{18}</td>
<td></td>
</tr>
<tr>
<td>Postscript</td>
<td>PS</td>
<td>Level II</td>
<td></td>
<td>S\textsuperscript{12}</td>
<td></td>
</tr>
<tr>
<td>Postscript</td>
<td>PS</td>
<td>Level II, III</td>
<td></td>
<td>S\textsuperscript{2}</td>
<td></td>
</tr>
<tr>
<td>Professional Write</td>
<td></td>
<td>1.0 to 2.1</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Professional Write Plus</td>
<td></td>
<td>1.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Q &amp; A</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Q &amp; A Write for Windows</td>
<td></td>
<td>3.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>R:BASE 5000</td>
<td></td>
<td>1.0 to 3.1</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>R:BASE System V</td>
<td></td>
<td>1.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Reflex</td>
<td></td>
<td>2.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>RLE Intergraph Runlength</td>
<td>RLE</td>
<td>All</td>
<td></td>
<td>P¹</td>
<td></td>
</tr>
<tr>
<td>Samna Word</td>
<td></td>
<td>1.0 to IV+</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>SmartWare II</td>
<td>DEF</td>
<td>1.02</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>SolidWorks 2D</td>
<td>SLDDRW</td>
<td>2008 and below</td>
<td></td>
<td>C¹</td>
<td></td>
</tr>
<tr>
<td>Sprint</td>
<td></td>
<td>1.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>StarOffice Calc</td>
<td>SDC</td>
<td>All</td>
<td></td>
<td>C¹³</td>
<td></td>
</tr>
<tr>
<td>StarOffice Impress</td>
<td>SDA</td>
<td>All</td>
<td></td>
<td>C¹³</td>
<td></td>
</tr>
<tr>
<td>StarOffice Writer</td>
<td>SDW</td>
<td>All</td>
<td></td>
<td>C¹³</td>
<td></td>
</tr>
<tr>
<td>Sun Raster</td>
<td>SRS</td>
<td>All</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>SuperCalc 5</td>
<td></td>
<td>4.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Tagged Image File Format</td>
<td>TIF, TIFF</td>
<td>All</td>
<td></td>
<td>C</td>
<td>P¹⁸</td>
</tr>
<tr>
<td>Text Mail</td>
<td>MIME</td>
<td>All</td>
<td></td>
<td>C</td>
<td>P¹⁸</td>
</tr>
<tr>
<td>Total Word</td>
<td></td>
<td>1.2</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Truevision Targa</td>
<td>TGA</td>
<td>2</td>
<td></td>
<td>C</td>
<td>P</td>
</tr>
<tr>
<td>Unicode Text</td>
<td>TXT</td>
<td>All</td>
<td></td>
<td>C</td>
<td>P</td>
</tr>
<tr>
<td>Unigraphics SolidEdge 2D</td>
<td>DFT</td>
<td>8 to 20</td>
<td></td>
<td>C¹</td>
<td></td>
</tr>
<tr>
<td>UNIX Compress</td>
<td>GZ</td>
<td>All</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>UNIX TAR</td>
<td></td>
<td>All</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>UUEncode</td>
<td></td>
<td>All</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>vCard</td>
<td>VCF</td>
<td>2.1</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Volkswriter 3 &amp; 4</td>
<td></td>
<td>1.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>VP Planner 3D</td>
<td></td>
<td>1.0</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Wang PC</td>
<td>IWP</td>
<td>1.0 to 2.6</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Wavesoft</td>
<td>MOT</td>
<td></td>
<td></td>
<td>P¹</td>
<td></td>
</tr>
<tr>
<td>WBMP</td>
<td></td>
<td>All</td>
<td></td>
<td>P</td>
<td></td>
</tr>
</tbody>
</table>
### Rendering Notes:

1. Requires CAD license.
2. Requires Ghostscript.
3. Supports Hypertext Markup Language (HTML) with Cascading Style Sheets (CSS).
6. Requires WordPad.
7. The PDF will be a report of technical file information.
8. Only NSF files with one email are supported.
9. WordPad will be used to convert the document unless Microsoft Word is installed.
10. The Encapsulated PostScript (EPS) file specification allows a graphic file to be included for screen preview. The graphic file formats supported are: PICT (MAC), TIFF, Metafile and EPSI. The Adlib Transformation Engine only supports EPS files with TIFF graphic file format.
11. Requires Recognition license.
12. In some instances PostScript files have a loss in fidelity when rendering. Native Application (Ghostscript) processing produces higher quality PDF files and is recommended.
13. Requires OpenOffice.org equivalent (Calc, Impress or Write).
15. If using Microsoft Office 2007 NAS to render, Service Pack 2 is required.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extensions</th>
<th>Versions/Formats</th>
<th>NAS</th>
<th>Adlib</th>
<th>Generic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Enhanced Metafile</td>
<td>EMF</td>
<td>All</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Windows Metafile</td>
<td>WMF</td>
<td>All</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Wireless Markup Language</td>
<td>WML</td>
<td>5.2</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>WordMARC</td>
<td></td>
<td>1.0 to Composer</td>
<td></td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>WordPerfect Graphics</td>
<td>WPG, WPG2</td>
<td>1.0 to 2.0</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WordStar</td>
<td></td>
<td>1.0 to 7.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WordStar 2000</td>
<td>DOC</td>
<td>1.0 to 3.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WordStar for Windows</td>
<td>DOC</td>
<td>1.0</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X-Windows Bitmap</td>
<td>XBM</td>
<td>x10 compatible</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X-Windows Dump</td>
<td>XDM</td>
<td>x10 compatible</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X-Windows Pixmap</td>
<td>XPM</td>
<td>x10 compatible</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XSL Formatting Objects</td>
<td>FO, XML</td>
<td></td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>XyWrite</td>
<td>XYP</td>
<td>1.0 to III Plus</td>
<td>P</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
16. Contents of the Zip file are merged into a single output. Contents appear in the order they were added to the Zip file.

17. It is recommended that High Quality printing be enabled within the PowerPoint 2007 native application. This setting provides the best quality when rendering PowerPoint files through the Adlib PDF Transformation Engine.

18. Extended File Type Support will only be used if there was a failure rendering the image file through the Adlib Image Viewer and the ConvertToPdf.Generic rule setting is applied within the Transformation Rules.

19. Autodesk Inventor View 2011/2012 must be installed prior to the Transformation Engine to support the rendering of these files when the ConvertToPdf.Cad setting has been configured under the Transformation Rules.

Additional file types are continually being added. If the file type you are looking for is not listed please email Adlib at support@adlibsoftware.com.

**General Notes:**

a) This list only contains the most common file extensions used for each file type. Other file extensions may exist.

b) File extensions are not used to identify the file type except for CAD files and files that do not contain file information (e.g. HPGL).

c) Please let us know if you need additional file type support.
Appendix D: Troubleshooting

Overview
This section serves as a guide to help troubleshoot problems that might occur while using Adlib PDF. It provides direction for diagnosing common issues and describes the steps required for resolution. It also offers tips on how to use Adlib PDF effectively.

- **Common Issues**
- **Adlib Tips**
- **Using Metadata**

Common Issues

**Rule Set is locked**
- Capture and save the screen
- Log back in as the user that had the Rule Set locked
- The lock will be reset.

**Rule doesn’t seem to be taking effect**
- Verify that the Rule script is correct:
  - Check for the correct use of quotes
- For Transformation or Job Acceptance Rules:
  - Confirm that the Instruction Set is published (check the Active Rule Set)
- For Component Initialization Settings:
  - Confirm that the Environment is published.
  - Ensure affected Components are restarted.
  - Investigate the Job Processing sub-tab in the Job Status log.

Refer to [Job Status](#) for parameter details.

**Job information is not appearing on the Job Status / System Log screens**
- Check the selected start and end date in the log filters.
- Ensure that no filters are active.

**Installation does not complete successfully**
- If one exists, check the installation log file.
- Ensure prerequisites have been installed.
- Enable verbose logging
Forgot password to access Adlib PDF
- Ask your Database Administrator to check your Settings in the database’s user table.

Management Console screen is frozen (screen is grey)
- Close your browser and re-open it.

File failed to process (it was placed in the error folder)
- Navigate to the Job Status and check job details.
- Filter the Job Status to the job in question.
- Navigate to the System Log and check for errors.
- Generate a problem report.

E-mail notifications not sent when Components go offline
- Email notification is not available in the Adlib PDF Express edition. Contact Adlib for more information on the Adlib PDF Enterprise edition.

Adlib Tips

How to maintain your database
If not properly maintained, the database will eventually grow to an unacceptable size.
- Set up a regular schedule (perhaps once a month) to clear the els_log entries.
- Enable e-mail notifications through the SQL Server.

How to correctly unassign a Folder Connector from the Environment
Connectors must be removed in the reverse order in which they were added.
1. Navigate to Sources tab under System Settings.
   - Edit the Source in which the Connector is assigned.
   - Click the minus sign beside the Connector name to remove it and click Save.

   Be sure to remove the Connector from all Sources in which it is assigned.

2. Navigate to Job Settings.
   - Edit the Instruction Set in which the Source (which contained the Connector above) is assigned.
   - Drag the Source from the Instruction Set work area to the toolbox.

   Repeat for all Sources which contained the Connector.

3. Navigate to the Environment tab under System Settings.
   - Edit the Environment in which the Connector is assigned.
   - Click the minus sign beside the Connector name to remove it and click Save.
Using Metadata

The term metadata refers to contextual information that describes elements of a set of data, defined as name/value pairs. Metadata examples include input file size, folder name, document status, etc.

Within Adlib PDF:

- Users can define the metadata to be used
- Related metadata can be grouped under a single name
- Jobs can be run once to populate all available metadata
- Metadata can be obtained automatically from many repositories

Metadata Selector

The Metadata Selector window opens when the Metadata button is clicked in Setting Attribute windows.

Submit / Consume

When selecting Metadata, the terms Submit and Consume refer to metadata submitted by and returned to Components:

- **Submit Metadata** is metadata provided by a Component that the Rules Engine uses during evaluation (e.g. Component type, machine name, etc.).

- **Consume Metadata** is metadata provided by the Rules Engine to a Component for consumption during processing (e.g. header/footer Settings, watermark text, margins, etc.).

Consumable metadata elements used for initialization are defined as Settings and represent a particular XML schema. When inactive, the schema can be modified through the target Rule.
Variables Tab

Default Variables will appear under the Variables tab if they have usage assigned.

- **Variables Used to Identify Components** are Variables of usage type **Submit**.
- **Variables Submitted with Jobs are Variables** of usage type **Submit** that are also associated to any Connector Component type.
- **Variables Used to Initialize Components** are Variables of usage type **Consume**.

*Figure 110 - Metadata Selector Variables*
To Select a Metadata Variable

1. Click the arrow beside the type of Variable to be used.
2. Drill down and select one of the Variables listed.
3. Click **Insert Selection**.

*Figure 111 - Metadata Variable Selection*
Values Tab

The Values tab is used to insert tokens that identify certain types of objects registered to the system. These tokens will be resolved to the correct unique identifier for the selected object type. Typically used in Rule Conditions, users can easily insert:

- Machine IDs,
- Installed Component IDs,
- Component Type IDs, and
- Source IDs.

*Figure 112 - Metadata Selector Values*
To Select a Metadata Value

1. Click the arrow beside the type of Value to be used.
2. Select one of the values listed.
3. Click Insert Selection.

Figure 113 - Metadata Value Selection
Appendix E: Contact Adlib

Web Site      www.adlibsoftware.com/
Sales         sales@adlibsoftware.com
Support       support@adlibsoftware.com
Phone         1-905-631-2875 or
              1-866-991-1704 (North America Only)
Fax           1-905-639-3540
Mail          Adlib
              215-3228 South Service Road
              Burlington, Ontario L7N 3H8
              Canada
Appendix F: Index

A
Alarm .................................. 19, 77, 83, 97

C
Completed On .............................. 71
Component ................................ 17
Component Friendly Name .............. 80
Component Initialization Settings .... 29
Component Status ....................... 77
Component Type ......................... 72, 77
Connector ................................ 10, 17
Content Transformation Viewers .... 50

D
Database ................................ 19
Database Growth Management ........ 106
Configure Settings ..................... 107
Database Tables ......................... 107
Modes .................................... 106
Drop Zone ................................ 19

E
Engine Complete Time ................... 74
Engine Start Time ......................... 74
Environment ............................. 11
Environment Name ...................... 71, 77
Environments ................................ 20
Remove Environment Components .... 26
Sort Environment Components ....... 27
Sort Unassigned Components ....... 27
View Component Information ......... 28

F
Fault, Monitoring and Recovery Settings .. 31
Folder Connector ......................... 32

H
Heartbeat ................................. 19
High Availability ......................... 19
How To
  Change or Remove Connectors ....... 38
  Define a New Environment .......... 22
  Define a New Source ................. 35
  Filter Source Folders ............... 38
  Remove Environment Components ... 26
  Sort Environment Components .... 27
  Sort Source Folders ................ 38
  Sort Unassigned Components ...... 27
  Unregister an Environment Component .. 26
  View Source Folder Information ... 39

I
Install Path ................................ 72, 77
Instruction Set ........................... 17
Instruction Set Options ................. 43

J
Job Completion Code ..................... 74
Job Completion Description ............ 74
Job Completion Detail ................... 74
Job Id .................................... 71
Job Management Service .............. 10, 31
Job Settings ............................. 40

L
Log Level ................................ 77
Logger .................................... 10, 32

M
Machine Name ........................... 72, 77
Management Console ................... 12
Monitoring ................................ 17

P
PDF Optimization ......................... 11
Priority ................................... 71
Problem Submission .................... 69, 85
Process Manager ......................... 10, 32
Publishing ................................ 19

R
Redundancy ............................... 19
Rule Set Editor .......................... 12
Rule Set Editor Page .................... 29
Rule Sets ................................ 11
Rule Settings Syntax ................... 50

S
Services .................................. 10
Source .................................... 11, 17
Source Folder Options .................. 11, 17
Change a Connector ..................... 38
Remove Connectors ........................................................................................................38
Started On ..................................................................................................................71, 77
Status ............................................................................................................................71
System Manager ............................................................................................................10, 30

T

Timeout Interval(s) .......................................................................................................78
Toolbox ..........................................................................................................................19
Transformation Engine .................................................................................................10, 31

U

Updated On .....................................................................................................................71, 78

V

Variables .........................................................................................................................11, 127
Local Variables .............................................................................................................11

W

Work Area .......................................................................................................................19